& Paclasalai’s

weoo lelegram Groups!

( smeolIB@ H6p 2 eiten eIBens Hefld CFUIH Gupaled Rewewruiad! )

e Padasalai's NEWS - Group
https://t.me/joinchat/NIfCqVRBNj9hhV4wu6 NgA

e Padasalai's Channel - Group
https://t.me/padasalaichannel

e Lesson Plan - Group
https://t.me/joinchat/NIfCqVWwo5iL-21gpzrXLw

e 12th Standard - Group
https://t.me/Padasalai 12th

e 11th Standard - Group
https://t.me/Padasalai 11th

e 10th Standard - Group
https://t.me/Padasalai 10th

e 9th Standard - Group
https://t.me/Padasalai 9th

e 6th to 8th Standard - Group
https://t.me/Padasalai 6to8

e 1stto 5th Standard - Group
https://t.me/Padasalai 1to5

e TET -Group
https://t.me/Padasalai TET

e PGTRB - Group
https://t.me/Padasalai PGTRB

e TNPSC - Group
https://t.me/Padasalai TNPSC



https://t.me/joinchat/NIfCqVRBNj9hhV4wu6_NqA
https://t.me/padasalaichannel
https://t.me/joinchat/NIfCqVWwo5iL-21gpzrXLw
https://t.me/Padasalai_12th
https://t.me/Padasalai_11th
https://t.me/Padasalai_10th
https://t.me/Padasalai_9th
https://t.me/Padasalai_6to8
https://t.me/Padasalai_1to5
https://t.me/Padasalai_TET
https://t.me/Padasalai_PGTRB
https://t.me/Padasalai_TNPSC
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5. WORKING WITH TYPICAL OPERATING SYSTEM
PART -1 WORKING WITH WINDOWS
PART - II WORKING WITH LINUX
SECTION - A

Choose the correct answer:
1. From the options given below, choose the operations managed by the operating system.

a. Memory b. Processes c. Disks and I/O devices  d. All of the above
2. Which is the default folder for many Windows Applications to save your file?

a. My Document b. My Pictures c. Documents and Settings d. My Computer
3. Under which of the following OS, the option Shift + Delete — permanently deletes a file or
folder?

a. Windows 7 b. Windows 8 c.Windows10 d. All of the OS
4. What is the meaning of "Hibernate" in Windows XP/Windows 7?

o

Restart the Computer in safe mode

o

. Restart the Computer in hibernate mode

(@)

. Shutdewn ihe Conipuier termiziating all the running appiications

cu

. Shutdown the Computer without closing the running applications
5. Which of the following OS is not based on Linux?
a. Ubuntu b. Redhat c. CentOS d. BSD
6. Which of the following in Ubuntu OS is used to view the options for the devices installed?
a. Settings b. Files c. Dash d. VBox GAs 5.2.2
7. Identify the default email client in Ubuntu.
a. Thunderbird  b. Firefox c. Internet Explorer d. Chrome

8. Which is the default application for spreadsheets in Ubuntu? This is available in the software

launcher.
a. LibreOffice Writer b. LibreOffice Calc
c. LibreOffice Impress d. LibreOffice Spreadsheet

9. Which is the default browser for Ubuntu?
a. Firefox b. Internet Explorer c¢. Chrome d. Thunderbird

10. Where will you select the option to log out, suspend, restart, or shut down from the desktop of
Ubuntu OS?

a. Session Indicator b. Launcher c. Files d. Search
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SECTION-B

Short Answers

1. Differentiate cut and copy options.

Cut

Copy

An option that allows the user to move the

content from one document to another.

An option that allows the user to make a

duplicate of the original content.

The shortcut keys used for moving a text is

Ctrl + X

The shortcut keys used for copying a text is
Ctrl +C

2. What is the use of a file extension?

A file extension or file name extension helps to identify the type of file. The extension indicates a

characteristic of the file contents or its intended use.

Examples: .txt, .doc / .docx, .odt, .ods, .odp
3. Differentiate Files and Folders.

Files

Folders

" A file consists of a collection of data.

A folder stores files anc folders. It is also called

a directory.

Each file has its own extension.

Folder and sub foidzr caanot be ¢reated in 3 file

A folder does not have any extension
o\
Folder and sub folde~ can be created in a folder

4. Differentiate Save and Save As option.

Save

Save As

Save” command is use to save a document by

only one name

“Save As” command we can save a file by two

or more than two names.

The shortcut keys used for save a text is

Ctrl + S

The shortcut key used for Save As in MS-Word
is F12

The shortcut keys used for Save As in Open
Office is Ctrl+Shift+S

5. What is Open Source?

Open Source refers to a program or software in which the source code is available in the web to the

general public free of cost.
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6. What are the advantages of open source?

* Open source is available in the web to the general public free of cost.

* Open-source software is more secured as the code 1s accessible to everyone.

* Open source code can continuously improve by the programmers in the web.

7. Mention the different server distributions in Linux OS.

The most popular Linux server distributors are:

* Ubuntu Linux

* Linux Mint

* Arch Linux

* Deepin

* Fedora

* Debian

* CentOS

8. Iicw will you log off from Ubuntu OS?

After finishing your work, you can choese Log Ont, Suspend or Shut down througii the Session

Indicater on the far right sicie of the top panel to log off your computer.
SECTION-C

Explain in Brief

1. Analyze: Why the drives are segregated?

* Drives are segregated to organize the space on a hard drive.

* It is also used to isolate the operating system or programs from other user.

* You Can Use Multiple Operating Systems On The Same PC in different drives.

* Hard disk drives usually work better on smaller chunks of data rather than one big partition.

2. If you are working on multiple files at a time, sometimes the system may hang. What is the
reason behind it. How can you reduce it?

*Each application open on the system takes some internal and hardware resources to keep it
running.

*If you are running multiple programs at one time then, much more storage will be in use to run
them properly.

* So your PC may run low or hang.

*To avoid this, it is advisable to run one program at a time or upgrade your Pc’s Configuration to
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run multiple applications at the same time.
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3. Are drives such as hard drive and floppy drives represented with drive letters? If so why, if
not why?

*Yes hard drives and floppy drives can be identified by drive letters such as "C:", "D:", "E:" etc.
*A drive letter is a single alphabetic character A through Z that has been assigned to a physical

computer drive.

=1 My Compuber " = II:Il x|
Fil= Edit = Faworike ”l
e Back ~ =— - [+ I 2=
Sddress I’ED_ 1w Compukber "'I PGD
= = =
S Flopps Local Disk [ =TT
LS [y wolume ()
Pt
[T Compack Conkral
wWolume (E: D Cri=c (F:2 Farn=l
& cei==ri=s | T== ea, Co =

*In the above example,

Drive A: is the floppy drive,

C: is the primary hard drive,

D: and E: are partitions of the hard drive, and

Typically, the CD-ROM drive 1s the last drive letter, so in 1:0st situaticns the hard drive s the

C: drive .

4, Write the specific use of Cordana.

* Cortana is a voice-controlled virtual assistant for Microsoft Windows.

* Cortana is used to get weather forecasts, set reminders, Entertainment, send emalil,
Maps/Navigation, Random tips and tricks, find files, search the Internet and so on.

5. List out the major differences between Windows and Ubuntu OS.

Windows Ubuntu

Windows is a closed-source operating system | Ubuntu is an open-source Linux-based

operating system

Majority of Windows OS is developed by Ubuntu is v op Canonical Limited.
Microsoft

Windows supports the office suite called MS Ubuntu supports the office suite called
Office. LibreOffice.

Default web browser for Windows OS is Default web browser for Ubuntu OS is Firefox.

Internet Explorer.
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6. Are there any difficulties you face while using Ubuntu? If so, mention it with reasons.

Yes, many difficulties are these while using Ubuntu operating system

* It becomes difficult to configure modem to start work on internet.

* It 1s not possible to play the modern games in Ubuntu OS. It shows the poor graphics quality

* Though Linux (Ubuntu) has number of free applications and software available on net, but most

of the applications are not found for Linux use.

* Ubuntu is not capable of playing MP3 files by default.

* The drivers support is also absent in most of the cases as compared other operating system.

* Different desktop managers lead to a fragmented experience.

7. Differentiate Thunderbird and Firefox in Ubuntu OS.

Thunderbird

Firefox

called Thunderbird

Ubuntu has in-built email software

Firefox is a Web Browser, you can directly

browse the internet

Exchange, Gmail, Hotma’l, etc.

It gives the user access to email siich as

Firefox is great for new users fo the Web as

well as long time Web surfers.

8. Differentiate Save, Save As and Save a Copy in Ubuntu OS.

Save

Save As

Save a Copy

In U untu, th “Save” option

will save the document

without requesting for a new

location or name.

In Ubuntu, the “Save As”
option, it will prompt the task
of saving with the help of a

dialog box.

In Ubuntu, the “Save A Copy”
you will be prompted to save a
copy using the same dialog

box as “Save As”.

It will definitely over-write the

original one.

You can easily change the

name of file as well as

location.

You may change the file name

as well as location.
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-D

1. Explain the versions of Windows Operating System.

Versions Year Specific fealures
. « Introduction of GU Lin 16 - bit, processor
Windows :
i 1985 |« Mouse was introdoced as an imput
' device.
« Supports to minimize or maximize
windows.
Windows :
3 1987 |« Control panel feature was introduced
= MICROSOFT with wvarions system settings and
WNDOWS customsing options,
« Introduced the concept of multitasking.
Windows (5951 Supported 256 colours which brought
3x : f a more moden, coloarfud ok (© the
“’T"‘D&J‘i’i"—"i : intezrgace.
= I s i e e R e N e e R e A e
— = = === - —————————
|« introduced Sturi buiton, ihe iuskbar,
Windows {505 Windows Explorer and Start menu.
95 « Introduced 32 bit processor and
focused more on  multitasking.
WINDOWS
« Integration of the Web browser (Internet
Explarer) with the Cyperating System.
Windows P. ; : P g !
6 1998 [« [0S gaming began to disappear as
Windows based games improved.
WINDOWS + Plug and play feature was introduced.
Windows : :
NT » Designed to act as servers in network.
k
MICROSOFT
WINDOWS
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Windows

Me

2000

automated
Lecovery

« It introduced

diagnostics

system

and tools.

Windows
ZiHH0

20040

« Served as an Operating System for
business desktop and laptop systems.
+ Four versions of Windows 2000 were
released: Professional (for business
desktop and laptop systems), Server
(both a Web server and an ofhice server),
Advanced Server (for line-of-business
applications) and Data Centre Server
(for high-traffic computer networks).

Windows
XPp

2001

Windows
Vista

zio

« [Introduced 64-bit Processor.
« Improved Windows appearance with

| « Updated the louk and feel of Windows.

Windows 7

2005

« Booting time was improved, introduced
new user interfaces like Aero Peek,
pinning prograins Lo taskbar,
handwriting recognition and
Internet Explorer 8.

elc.

Windows 8

B Windows 8

2012

« Windows 8 was faster than previous
versions of Windows.

= Start button was remowved.

« Windows 8 takes better advantage of
multi-core processing, solid state drives
(5512}, touch screens and other alternate
input methods.

« Served as common platform for mobile
and computer.

Windows
10

Send Y

pur Eys 1

2015

O our en

« Start Button was added again.

« Dhultiple desktop.

« Central Notification Center for App
notification and quick actions.

nailish rpadesalal Ref@geab«enal assistant.
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2. Draw and compare the icon equivalence in Windows and Ubuntu.

Icon Windows Icon Ubuntu
My Computer Files
Recycle Bin Trash
L
= Internet Explorer Fire Fox
: b -
ﬁﬂ’_gf MS-Word LibreOffice Writer
,,,,"_::::_ii
‘X‘J MS-Excel LibreOffice Calc
MS-PowerPoint LibreOffice Impress
p ! Search Prograrns and Files 27 | Search vour comnuter

Ubuntu
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3. Complete the following matrix

www.TrbTnpsc.com

Navigational Me

Located on

Ideally suited for

Start button

Task bar

The Start menu can be used
to quickly start the installed
programs as well as other
Windows features

My Computer

Desktop

Exploring your disk drives and
using system tools

Windows Explorer

Task Bar

Seeing  hierarchy of all
computer contents and
resources in one window.

Quick Launch

Task Bar

Enables a user the ability to
launch their programs
quickly

4. Observe the figure and mark all the window elements. Identify the version of the Windows

The version of OS is Windows 7
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Title Bar
Corners Borders Corners
— — —
T'nv—n-n—-h--v-i' = Y 1
vlenu bar =

m, !
Bl Hﬁlﬂ-#ﬂn-ﬂifu -'-'Iim-ul_
Ii.'lug.-" EI-"l--'!mh-n- e E-fu.llIEtE

] S R o fem gl i i . T T

i
——

|
r :
Scroll Bar B
& n .
-
-!' i
i Workspace
. I I Il|
|- EE ‘
L i — R ——————— | i i
IR = sl  WWT \NTE | P —————— T *
'._'H-I—-rl_lnl_-l—q.._ 3 S
—
Borders
COERers Corners

Figure 5.10 The elements of a window.

Title Bar - The title bar will display the name of the application and the name of the document
opened.
Menu Bar -The menu bar is seen under the title bar.

The Workspace -The workspace is the area in the document window to enter or type the text of
your document.

Scroll bars - The scroll bars are used to scroll the workspace horizontally or vertically.

Corners and borders -The corners and borders of the window helps to drag and resize the

windows.
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5. Write the
procedure to
create, rename,
delete and save a
file in Ubuntu
OS. Compareit
with Windows

OS.

Procedure in Ubuntu
OS

Create a file -A new
File or new Folder
can be created by
using File>New
meau or right click
the mouse button and
thea select the type ¢f
file to create.

Rename a file - Select
the file or folder to be
renamed, right-click,

and select Rename

from the context menu. Type the
new name for the file / folder, and
press Enter. The file or directory
1s renamed. Or rename with th
“mv comman ”’

Delete a file - A file / folder created
by you can be moved to trash by
using right click or by using menu.
Or use rmdir. Example:
rmdir('myfiles')

Save a file - To save the file

and exit at the same time, you

can use the ESC and :X key

and hit [Enter]. Optionally,

press [Esc] and type Shift +

7. to save and exit the fiie.

Pracedure in Windows OS
Create a file — To create a text
file on a computer you need a
text editor such as wordpad.
Choose File>New or Ctrl+N.
Rename a file — Select the file/

www.TrbTnpsc.com

folder need to renamed and do
any one of the following,

* Click File=>Rename menu,
or

* Right click the file or folder
and choose rename option, or

* Press F2 then Type the new
name and press enter.

Delete a file - Click
File>Delete or press Delete
key then the deleted file or
folder will move into the
Recycle Bin

Save a file - Save the content
of the file using File > Save or
Cirl + S.

6. INTRODUCTION TO WORD PROCESSOR

Choose the correct answer

SECTION - A

1. Which is the opening screen of OpenOffice?

a. Star desktop

b. Star center

c. Star screen

d. Star window

2. Which option allows you to assign text, tables, graphics and other items to a key or key

combination

a. Auto format

b. Automatic c. Auto text

3. Which menu contains the Numbering option.

a. File

b. Edit c. Tools

d. Auto graphics

d. Format
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4. Which i1s displayed at the top most part of the window?

a. Menu bar b. Tool bar c. Title bar d. Format bar
5. Which is changing the default appearance of the text called?

a. Text formatting b. Page formatting

c. Special formatting d. Paragraph formatting
6. The Find & Replace option is available in which menu?

a. File b. Edit c. Format d. Tools

7. Which button selects all instances of the search text in the document?

a. Find b. Find All c. Replace d. Replace All
8. What is the shortcut key to go to the start of the document?
a. Ctrl + Home b. Ctrl + End c. Home d. End

9. What is the shortcut key for finding and replacing text in a document?

a. Ctrl + F1 b. Ctrl + F c. Ctrl + F5 d. Ctrl +F7
10. What is the short cut key for Uido?
a. Ctrl +E b. Ctrl + 1 c.Corl+7 d. Ctrl +n
SECTION-B

Short Answer's

1. How do you insert pictuies in 0 your document?

Open office Writer has the ability to insert and edit images in a more simple way.
Place the insertion pointer where you want the image to appear

* Select Insert = Picture = From file
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*The insert picture dialog box appears where the picture gallery opens from which the desired
picture can be selected.

* If the picture is not in the gallery, then browse the pictures from the folder, choose the desired one
and Click on the Open button

* The selected picture is inserted into the document

2. What are the different packages in OpenOffice?

OpenOffice is a productive office suite with a collection of different software packages such as

OpenOffice Writer - Word Processor to create text documents
OpenOftice Calc - Spreadsheet to createworksheets
OpenOffice Base - Database

OpenOffice Impress - Presentation software

OpenOftfice Draw - Drawing Software

Cpenlitice Formula - Create formula and equations

3. What is auto text in wiiter?

AuwTexar 2llows vou to assign text, tables, graphics and other items 1o a key or key comboination.
For example, rather than typing '"Tami'Nadua" every time you use that phrase, you migat just type
"wi'" and press F3.

4. How do you merge cells in a table?

To merge a group of cells:

* Select the cells to merge.

* Right click and choose Cell >Merge or

*Choose Table >Merge Cells from the menu bar.

5. State the difference between proprietary software and open source software?

Proprietary software Open source software
Package Developer Package Developer
Microsoft Word Microsoft Corporation | OpenOffice Writer Apache
The document
WPS Word Kingsoft LibreOffice Writer
foundation
‘WordPro Lotus Corporation Abiword Abisource
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SECTION-C
Explain in Brief

1. What is the difference between moving and copying text?

Moving text Copying text
To move a text from one location to another To copy a text from one location to another
Select the text to be moved select the text to be copied
Click Ctrl + X or Cut Icon X or Edit 2> Cut Click Ctrl + C or Copy Icon or Edit > Copy

The text is removed from the source location and | A duplicate copy of the text 1s made and

placed in the clipboard send to the clipboard

Take the insertion pointer to the new location to | Take the insertion pointer to the new

be moved location to be copied

2. What are the different types of orientation?

There are two ditferent orientations:

Landscape — The width of the document 1s more than the height. This is best suited for displaying
professional photos, invitations, albums, tables etc.

Portrait — This is the most common and default orientation . Here, the height of the document is
more than the width. Normally books, newspapers will be displayed in this format.

3. How do you insert rows and columns?

* Place the insertion pointer in the row or in the column where you would like to add new rows or
columns and rightclick.

* Choose Row =>Insert — to insert a row or Column > Insert — to insert a column.

A dialog box will appear, from which you can select the number of rows or columns to insert. You
can also set the position of the new rows or columns to Before or After

4. What are the different ways to save a document?

* You can save by clicking File> Save on top left corner and then click File=>Save As or

Ctrl+Shift+S . After that browse the location where exactly you want to save in your computer.

* You can also save by just pressing Ctrl + S and then browse the location where you want to save.
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* All documents in OpenOffice writer will be stored with .odt extension. You can store your

OpenOffice document as Microsoft Word document or pdf.

Send Your Questions & Answer Keys to our email id - padasalai.net@gmail.com



www.Padasalai.Net www.TrbTnpsc.com

S. Write the steps to change the line spacing of text.
Rightclick—> line spacing, select the type single, 1.5 or double.
Select the entire document by Edit > Select All

* Format = paragraph

* The paragraph dialog box appears, click Indents & Spacing tab
* In the line spacing option, select the type and click OK button.

SECTION -D
Explain in detail
1. What are the different methods to change margin in writer?
Page margins are the white space around the top, bottom, left, and right of your document.
Changing or setting page margins in Openoffice writer can be done in two ways:
* Using the Rulers - quick and easy, but does not have precise values.
* Using the Page Style dialog box — can specify precise values for the margins.
Changing page margins - using Ruler
* The shaded sections of the rulers are the margins.
* Hold the mousc pouinter over the line beiween the gray and wiiie sections.
* The mouse pointer turns into a double headed aitow.
* Hold down the left mouse button and drag the mouse to move the margin and release it at the
required point.
* The new margin is set.
Using the Page Style dialog box
To change margins using the Page Style dialog box
* Right-click anywhere on the page and select Page from the popup menu and select page tab of
page style dialog box.
* In the Margins boxes, specify the values for left , right , top and bottom margins.
* Click on ok button.
2. What are Header and Footer? How do you insert page numbers?
The header is a section of the document that appears in the top margin, which displays the title or
chapter name , author name of a document.
* Select from the main menu Insert >Header - Default
* The header text area is separated from the normal text area.

* In the header area, Enter the text that is to be repeated in all pages or Select Insert >
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Fields - Title.
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The footer is a section of the document that appears in the bottom margin of the page which
displays the page number, date, time etc. which gets displayed on all the pages automatically.
* Select from the main menu Insert - Footer - Default
* Place the insertion pointer in the footer part of the page.
* Select Insert - Fields—> Date to insert date in all the pages.
Inserting and Formatting page numbers
The page numbers can be inserted by performing the following steps:
* Position the insertion pointer where you want to insert the page number
*choose Insert > Fields - Page Number
* The page number appears with a gray background
Normally, the page numbers appear as 1,2,3....., To change the numbering style, the
following sequence of steps can be performed:
* Position the cursor where the page number has to appear
* Scicet Format - page, which will bring the page style dialog box as on Figure 6.29.
* Select page Tso
* I the Layout settings, szlect the format drop down combo box
* Seclect the desiced sty e and click OK hutton.
3. Write the steps o Find and Replace a woird with anothei worda in OpenOiiice writer?
OpenOffice Writer has a Find and Replace feature that helps to locate for a text inside a document
and replace it with another word.
* Click Edit 2 Find & Replace (or) Ctrl + F
Steps to find & replace a text
* Type the text you want to find in the Search for box
For Example : To search a word "Bombay" in a document and replace with "Mumbai", enter the
word "Bombay" in the Search for box.
* To replace the text with different text, type the new text in the Replace with box
Enter the word " Mumbai" in the Replace with box and Click Find button , to start the search , the
found word is highlighted and the first occurrence of "Bombay" is highlighted.
* To replace text, click Replace button.
The highlighted word is replaced with the word given in the Replace with box.

* Click Find All, Writer selects all instances of the search text in the document .
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All occurrences of Bombay are highlighted.

* Click Replace All button, Writer replaces all matches.

This will replace all occurrences of

"Bombay" with "Mumbai".

* Enable Match case to perform the search case sensitively so that uppercase and lower cases are
distinguished separately.

* Enable Whole Words only to make the search more specific to words used separately alone.

\ i
Find & Replace -
Search for | Fird |
Finc
Bombay El TRUY B s e——
i Eind All !

Feplace with I 1
= | Replace |

| Mumbai |E| E

Re=l=ce 4l |

] Match case

I [C1 W h ole: wvwords only

Figure 6.30 Find 8 Replace dialog box
4. Explain Page formatting in
writer. Page formatting
The most important thing in a word processor is how to format the page with elements such as
margins, numbering, page layout, headers and footers. Formatting your pages makes them look
more attractive and makes them easier to read.
Changing page size
The default page size in writer is 8.5 x 117, the same as that of a standard A4 printing paper.
However, for different types of documents, you may need to change the page size. To change the
paper size:
* Select the page whose page size is to be changed
* Select Format = Page, the page style dialog box
* Select Page Tab
* In the paper format group, select the format like A4, legal ....
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* Or the width and height option can be used to set the page size.
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Changing Page margins

*Page margins are ‘the
white space around the
top, bottom, left, and
right of your docurent.

*Margins let Writer
know where to start
placing the text at the
top of a document,
when to move on to
the next page at the
bottom, where to start
typing text on the left
side, and where to stop
and move to the next

line on the right.

Changing or setting page
margins in Openoffice
writer can be done in two
ways:

quick and easy, but does not have

precise values.

* Using the Page Style dialog box
— can specify precise values for
the margins.

Orientation

Page orientation refers to how the
document will be displayed on
screen and printed. There are two
different orientations:

Landscape - The width of the
document is more than the height.
This is best suited for displaying
professional photos, invitations,
aloums, tables etc.

Portrait — This is thc most
common and default orientation.
Here, the height of the docurnent
is more thaiu the width, Wormally
books, newspapers will be

displayed in this format.

Page colour

Changing the page color is not
quite common. To do so, in the
Page style dialog box, select
Background tab, In As option
click on color and select the
“color” from the color palette or
select

“graphic” to apply an

1mage as a page background.
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Borders

Borders can be applied to an
entire document, an entire
paze, paragraph, or just to
certain  sections of the
document. From tie page
style dialog box, sclect the
Dorder tab, thc usci defined
area helps to define the area
of borders, the line style of

borders, color of borders can

be selected.
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7. WORKING WITH OPEN OFFICE CALC
SECTION - A
Choose the correct answer

1. Which is the first electronic spreadsheet?
(A) Excel (B) Lotus 1-2-3 (C) Visicalc (D) OpenOffice Calc
2. Which of the following applications was the parent to OpenOffice Calc?
(A) Visicalc (B) LibreCalc (C) Lotus 123 (D) StarOffice Calc
3. Grid of cells with a programmable calculator:
(A)Spreadsheet  (B) Database (C) Word processor (D) Linux
4. A column heading in Calc is represented using
(A) Number (B) Symbol (C) Date (D) Alphabet
5. Which key is used to move the cell pointer in the forward direction within the worksheet?
(A)Enter (B) Tab (C) Shift + Tab (D) Delete
6. A formula in calc may begin with
(A) = (B) + (C) - (D) Ali the abave
7. What will be the result from the following formuia (Assume Al=:5, B2:=2)7 + Ai"B2
(A)7 (B) 25 (C) 12 (D) 52
8. What will be the result from the following expression (Assume HI1=12, H2=12)? =
H1<>H2

(A) True (B) False (C) 24 (D) 1212
9. Which of the following symbol is used to make a cell address as an absolute reference?
(A) + (B) % O & D)$
10. Which of the following key combinations is used to increase the width of the current column?
(A)AIt + Right arrow (B) Ctrl + Right arrow
(C)Alt + Left arrow (D) Ctrl + Left arrow
SECTION-B

Short Answers
1. What are the types of toolbars available in OpenOffice calc?
There are three toolbars available by default. They are:

* Standard Toolbar * Formatting Toolbar * Formula bar
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2. What s a Cell pointer?

Cell pointer is a rectangle box which can be moved around the worksheet. The cell in which the cell
pointer is currently located is known as “Active cell”. When you type any content, it will appear in
the active cell.

3. Write about the text operator in OpenOffice Calc.

In Calc, “&” is a text operator which is used to combine two or more text. Joining two different
texts is also known as “Text Concatenation” An expression using the text operator has the following
syntax: text referencel & text reference2

4. Write the general syntax of constructing a formula in Calc.

General Syntax of constructing a formula is:

= cell referencel <operator> cell reference2 <operator> ...................

5. What are the keyboard shortcuts to cut, copy and paste?

Ctrl + X is used to cut the cell

Ctrl + C 15 used to copy the cell

Ctrl + V 15 used 10 paste the cell

6. Can you edit the contents of a celi? It yes, explain any one of the method of editing the
cell content.

Yes, we can edit the contents of a cell.

* Using keyboard, after selecting the cell, Press the F2 key and the cursor is placed at the end of the
cell. The use the keyboard arrow keys to move the cursor through the text in the cell.

7. What are the options available in “Insert Cells” dialog box?

There are four options available in Insert cells

* Shift cells down

* Shift cells right

* Entire row

* Entire Column

8. Match the following

SLNo A B
Cut, Copy, Paste Standard Toolbar
2 Cell Pointer Active Cell
3 Selection Mode Status Bar
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$A$5 Absolute Cell
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9. Define the following (i) Text Operator (ii) Rows and Columns of spreadsheet

Text Operator

In Calc, “&” 1s a text operator which is used to combine two or more text. Joining two different
texts is also known as “Text Concatenation” An expression using the text operator has the following

syntax: text referencel & text reference2

Rows and Columns of spreadsheet

*A row is a horizontal group of values within a table. It contains values for multiple fields, which
are defined by columns. The rows are numbered from 1, 2, 3.... OpenOffice Calc version 4.1.5
contains 10,48,576 rows.

*A column is a vertical group of values within a table. It contains values from a single field in
multiple rows. Each column is labelled as A, B, C, D ..... AA, AB, AC ....It contains 1024
columns.

10. Differentiate between Copy -Paste and Cut-Paste
Copy -Paste Cut-Paste

Select the cell or group of cells you want to copy. | Select the celi or group of cells you want to

e

|
- . . « '
then using Select Edit-» Copy or Click “Copy” |

cut, then using Edit => Cut oi Click “Cut” icon

icon from the standard toolbar or Press Ctrl -+ (C from tae stardard toolbar or Press Cirl + X

But in Moving it removes the information and
location and makes copy of the cell information o _
. pastes it in another location
when pasted it

Move the cell pointer to the cell in which you Move the cell pointer to the cell in which you
want to paste.Edit = Paste or Click “Paste” icon | want to paste. Edit = Paste or Click “Paste”

or Press Ctrl + V icon or Press Ctrl + V

SECTION-C
Explain in Brief
1. Write a short note on OpenOffice Calc.
* OpenOffice Calc is a popular open source spreadsheet application maintained by Apache
Foundation.
* StarOffice calc was the parent application of OpenOffice Calc which was developed by a German
Company namely, Star Division in 1985.
* Calc 1s the spreadsheet component of OpenOffice. You can enter any kind of data in a spreadsheet
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and then manipulate this data to produce certain results.
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2. Write about inserting columns and rows in Calc.

Inserting Rows - In Calc, we can insert a new row anywhere in the worksheet.

Step 1: Select the row where a new row to be inserted.

Step 2: Right-click on the row number, a pop-up menu appears

Step 3: click “Insert Rows” option from the menu.

Now, a new row will be inserted to above the current row. Insert = Rows command is used to insert
a new row.

Inserting a Column - In Calc, we can insert a new column anywhere in the worksheet.
Step 1: Select the column where a new column should be inserted.

Step 2: Right-click on the selected column name that you selected. A pop-up menu appears.
Step 3: click the “Insert Columns” option from the menu.

Now, a new column will be inserted to the left of the current column.

A new column can also be inserted using Insert = Columns command.

3. Ditierentiate Deleting data using Backspace and Delete

Backspace Delete
Eackspace key is used to delete the characier | Delete key is uszd to delete the character
left of the insertion pointer of the cell right of the insertion pointer ¢f the cell

4. Write any three formatting options.

Formatting Option Keyboard Shortcut Description
Bold Ctrl + B Used to make the data as
Bold
Italic
Ctrl +1 Used to [talicize data
Underline Ctrl+ U
Used to Underline the data

5.In cell A1=34 A2=65 A3=89 write the formula to find the average.
To find the average, using anyone of the following way:

i)= AVERAGE (A1:A3) =62.7%
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SECTION-D

1. Explain about changing the column width in Calc.
Resize the width of a column using the mouse

Use the right hand border to increase or decrease the width of a column.

o Position the cursor on the right hand border of the column letter box, until you see a double

headed arrow.
o Hold down the left hand mouse button and drag the border to the left or right to make the

column narrower or wider as required.

As you carry out this action, the width of the column displays.

| 1
Sk width: 1.16 = |Jf¢
A
i L
[ e
=

Using the mouse to widen a2 column
Resize one or more columns using Fermat
* Select the column(s) whose width you wish to change

* Select Format 2 Column = Width...

* The Column Width dialog displays

Width b.so- = oK |

o Default valus | Cancel |

[:} | Help |
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Enter a value in the Width window or check the Default value check box to select the default

column width.

* Click OK.

The selected columns display with the new width.

2. Write the steps to generate the following series. 5, 10, 20 ..... 2560

STEPS TO GENERATE THE SERIES 5,10,20,...2560

1. Select the required number of cells to generate the series.
2. Click EDIT-> FILL, the Fill Series dialog box appears as shown below,

Fill Series

Direction Series type Time unit
@ Down () Linear (@ Day
Right @ iGrowth! Weekday Cancel
(i3] () Dat Month R —
e D fote Mon F——
Left AutoFil Bar =N [
Start value 5
End value 2540
Increment 2

3. Select the Direction as Down in fill series dialog box.

4. Select the Series type Growth.

5. Initial value of the series 5 should be typed in Start Value box.

6. Maximum value of the series 2560 should be typed in End Value box.
7. The value 2 should be typed in Increment box .

8. Click OK. Now the series is generated as given below,

] = |

i 10
i 20
i <0
S0

150

320

540

1280

2560
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A B C D E
1 Year " Chennai Madurai Tiruchi | Coimbatore
2 2012 1500 1250 1000 500
3 2013 1600 1000 950) 350
1 2014 1900 1320 750 3-{_:"!]
> 2015 1850 1415 220 200
(i 2016 . 1950 1240 920 250

Above table shows the sales figures for “Air Cooler” sold in four major cities of TamilNadu

from the year 2012 to 2016. Based on this data, write the formula to calculate the following.
(1) Total sales in the year 2015.

(2) Total sales in Coimbatore from 2012 to 2016.
(3) Total sales in Madurai and Tiruchi during 2015 and 2016.

(4) Average sales in Chennai from 2012 to 2016

(5) In 2016, how many “Air Coolers” aie eold in Chennai compared to Coimbatore?

ANSWERY —— | || || — N o —_ | | — | |
SL.NO QUESTION FORMULA ANSWER
1 Total sales in the year 2015, | | =SUM(B5:E5) | 4285
Total sales in Coimbatore from 2012 to
2 =SUM(E2:E6) 1600
2016.
Total sales in Madurai and Tiruchi
3 _ =SUM(C5:D6) 4395
during 2015 and 2016.
Average sales in Chennai from 2012 to
a =AVERAGE(B2:B6) 1760
2016
In 2016, how many “Air Coolers” are
S sold in Chennai compared to =B6-E6 1700
Coimbatore?
8. PRESENTATION BASICS SECTION - A
Choose the correct answer
W : ) 0
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A) Compass B) Navigator C) Fill color D) Page border
2. Which is the shortcut key to view the slideshow?
A) F6 B) F9 C) F5 D) Both (b) or (¢)

3. In Impress, which views shows thumbnail versions of all your slides arranged in horizontal rows.
A) Notes B) Outline C) Handout D) Slide Sorter
4. Identify the default view in Impress.
A) Normal B) Slide Sorter C) Handout D) Notes
5. Which menu contains the Slide Transition option?
A) Slide Show B) View C) Tools D) Format
6. Identify the extension of the Impress presentation.
A) .odp B) .ppt C) .odb d. ,ood
7. In presentation tools, the entry effect as one slide replaces another slide in a slide show. Identify
the option that suits after reading the statement.
A) Animation B) Slide Transition C) Custom animation D) Rehearse Timing
8. Vanya has madg¢ a presentation on “Glcbal Warming”. She wants to progress her slide show

autrmaticaliy while speaks on the topic in the class. Which features, of Impress would she use?

A) Custom Arima‘icn B) Rehearse Timing
C) Slide Transition D) Either (a) or (b).
SECTION-B

Short Answers

1. What is the difference between a slide and a slide show?

Slide Slide Show

A slide 1s an editable format that contains
A slide show is a combination of a number of
different element like text, tables, charts, clip- art
slides that run one after the other.
ctc.
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2. How many in-built slide layouts does impress consist of?
In-built the open office impress consist of 12 different layout of slides.
3. What do you understand by a presentation?
A presentation program is a software package used to display information in the form of a slide
show. It has three major functions: an editor that allows text to be inserted and formatted, a method
for inserting and manipulating graphic images, and a slide-show system to display the content.
4. Define a template in Impress.
A template is a premade design you can use to lend cohesiveness, visual organization and appeal to
your presentation. Even though individual slides can have different layouts and graphics, templates
help the whole presentation go together as an attractive package.
5. What do you understand by the slide layout?
Slide layouts are pre-packaged layouts which contain formatting, positioning, and placeholders for
all of the content that appears on a slide.
Placeholders are the containers in layouts that hold such content as text ,tables, charts, SmartArt
graphics, movies, sounds, pictures, and clip art.
SECTION-C
Explain in Brief
1. How many types of views are provided by Impress to its users?
There are 5 types of views are provided by Impress. They are
Normal view - Normal view is the main view for creating individual slides.
Outline view - Outline view shows topic titles, bulleted lists and numbered lists for each slide in
outline format.
Notes view- Notes view lets you add notes to each slide that are not seen when the presentation
is shown.
Slide Sorter view - Slide Sorter view shows a thumbnail of each slide in order.
Handout view - Handout view lets you print your slides for a handout.
2. Who uses the presentation software and why?
Businesses and professional firms use presentations to inform, educate, motivate and persuade
internal and external audiences.
They build presentations into sales, training and internal communication programs, using the power
of words and images to engage their audience and retain attention. Presentation software is used to

create presentations, quizzes, e-learning packages and multimedia products.
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3. Define the Slide Sorter view and its significance.

The Slide Sorter view contains all of the slide thumbnails.

Use Slide Sorter view to work with a group of slides or with only one slide.

Use Slide Sorter view to reorganize, insert, delete and copy the slides, produce a timed slide show
or add transitions between selected slides.

4. What is a Normal view? Explain.

*Normal view is the main view for creating individual slides.

*Use this view to format and design slides and to add text, graphics and animation effects.

* There are two ways to place a slide in the Slide Design area of the Normal view: clicking the slide
thumbnail in the Slides pane or using the Navigator.

5. How are transition effects helpful in creating an effective presentation in Impress?
Slide transitions are the effects that occur when you move from one slide to the next during a
presentation.

Y on can control the speed, add scund, and customize the properties usiug the transition eiliccts.

Yo1u1 can also chesse between an automatic or manual transiticn.

SECTION-D
1. Valarmathi's teacher asks her to create a presentation in OpenOffice Impress. As
Valarmathi has never worked in Impress before, help her to perform the following tasks:
a. She wants that except for the first slide, all the slides should have the same design. For this,
what does she need to do?
*Create the presentation with same design for all slides using master page option, by clicking YES

in Page Setting dialog box
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*Click the Master slide and choose Format - Page menu. The Page setup dialog box appears on the
screen.

Page Setup (===
- Backgrownd |
Fill Size
3] Criginal Width
* Relative Height ;
B Space
EEEEE retal == Position -
| Droplets | | [ + —— |
~—_ | Marble | :rL o (J*
B Linen I”‘ |k -~ i~
MMercury -~ K Offset 0 %% =
e} |
= i ¥ Offset 0% [
EE== Brownstone Tile AutoFit
B retting T
Offset —
@ Row
) Column 0% =
I [ ok ][ cancel ][ Help | [ Re<et |

*Click Background and choose any onc of the Fill optiou ( Colour, Gradient, Bitmap, Hatclting) for

changing the backgrcuad of the master siide.

*The Page Setting dialog box appears on the screen,

()

Background settings for all pages?

Page Settings

* Click NO in the Page Setting dialog box.

* Now you can see the changes except for the first slide, all the slides will have the same design.
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b. To easily communicate with her audience, she wants to provide them with @ hiard
copy of the slides of the presentation. What should she create for it?

* Handout view is used for setting up the layout of your siides for a prirted handcu:.
¢. $he wants to insert some pictures and movie iiles in some slides. How can she do that?
* Select the slide to insert the picture.
* Choose Insert->Picture > From File option, and choose the required picture that has to be inserted
into the slide.
d. Suggest her the view that would be the most suitable for showing the presentation to
the audience.
* Use Slide Show view to deliver your presentation to your audience. Slide Show view occupies the
full computer screen, exactly the way your presentation will look on a big screen when your
audience sees it.
e. To make her presentation more attractive, she wants to add some effects in it. How
can she do it? Suggest.
* To make her presentation attractive, she needs to add animation and transition effects to the slides.
2. Explain how a presentation can help a salesperson to promote his/her products.
* Presentation is helpful for a sales person to promote his/her products effectively.
* Presentation will give visual video, pictures to understand a goodness of the product.

* By using presentation, sales person can make audience to understand easier and he can get more
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response from the people.
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* Presentation help sales person to present prospect challenges easier.

* Sales person can explain with physical demonstration by shocking animations. It helps to increase
the sales.

3. Sivabalan created a presentation to be shown at his school’s Annual Function. Just 5
minutes before the presentation, he noticed that he has misspelt the name of the
school, which is appearing in all the 30 slides of the presentation. How can he rectify
this mistake in all the slides in one-shot?

* The slide master will be helpful in this situation. Select the Master slide,

* Choose Edit = Find & Replace option from the menu bar. The Find & Replace Dialog box

appears on the screen,

| Find & Replace

Search for

i =] [ _End |

Replace with
| :_.,,'l |__ﬁe;:|ldci__|
VAR | Replace All |
] Match case
7] Whole words only
More Options = Help | | Close

* In the search for box type the misspelt word.

* Type the correct word in the Replace with box.

* Click the Find option to find the misspelt word.

* Click the Replace All option to replace the correct word in all the slides. You can see the

replacement in all the slides.

4. List some advantages of using templates.
Professional Graphic Design: Templates will give professional Graphic Design which helps you

to create branded PowerPoint presentation.
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own logo to the mix.
Speed: With a good starting point in each slide, your presentation is made in a snap.

Quick Customization: It’s much easier to edit the template in its original form, not as a copy of a

copy.
Consistency: A consistent design scheme will avoid jarring transitions and the sneaking suspicion

that the presentation was pasted together as a ransom note.

9. Introduction to Internet and Email
PART -1

Answer to the following questions (2 Marks):
1. List any four types of available networks? Types of
networks
Local Area Network (LAN) Metropolitan Area Network ( MAN )
Wide Area Network ( WAN) Personal Area Network( PAN)
Campus Area Network (CAN ) Wireless Local Area Network ( W-LAN )
2. Name the two important protocols for internet?

The internet uses TCP/IP(Transmission Control Protocol/ Internet Protocol ) to
transmit data via various types of media.
3. What is o network?

a network 1s a coilection or intercounccted deviees {such as computers, printers, ctc.).
4. What ic che role of ICANN ?
e Thc icsponsibilitv to promcte global informaticn exchange through *the internet technology.
Internet Corporation for Assigned Namsas and Nurmbers( [CANN) adrainisters the doraain rame
registration.
e It helps to avoid a name which 1s already registered.
5. What is a search engine?
[ ]
[ ]

A search engine is a software system that is designed to search for information on the World Wide Web.

Examples of popular search engines are Yahoo, Lycos, Altavista, Hotbot, Google and Askjeeves,
DuckDuckGo.

e The list of content returned via a search engine to a user is known as a search engine results page
(SERP).

6. What is a browser?

A browser is used to access websites and web pages whereas a search engine isused to
search for particular information.
Internet Explorer, Chrome, Firefox, Safari, etc.

A browser is used to access the Internet whereas in order to open a search engine you need a
browser.
7. What are the components of url addressing ?

URL: Uniform Resource Locator ex: http://www.google.com
1. Protocol: http://

2. Subdomain: WWW.

3. domain: google

4. top level domain(TLD): .com

8. What is a website?
e A website is a collection of webpages.
e The first page of the website is called a Home Page.
e All of these pages together make up a Website.
9. What is CC and BCC in an email?
The CC (Carbon Copy) field allows you to specify recipients who are not direct addressees
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(listed in the "To" field). This field is optional.
The BCC (Blind Carbon Copy) field is similar to CC, except the recipients are secret. Each
BCC recipient will receive the e-mail, but will not see who else received a copy. The
addressees (anyone listed in the "To" field) remain visible to all recipients.
This field is optional.
10. What is a Static web Page?
e The content and layout of a web page is fixed
e Static Web pages are easy to develop
e Static Web pages never use databases
11. What is a Dynamic web page?
e The content and layout may change during run time
e Dynamic web page development requires programming skills
e Databases is used to generate dynamic content through queries
12. What are the benefits of e-governance?
e Reduced corruption
e High transparency
e Increased convenience
e Reduction in overall cost.
e Expanded reach of government
13. What is Phishing ?
e Phishing is a type of computer crime used to attack, steal user data, including login name, password
and credit card numbers.
e It occurs when an attacker targets a victim into opening an e-mailor an instant text message.
PART-III
Answer to the follewing questions (3 Marks):
1. Differentiate PA™ and CAN retwork.
. PANNETWORK |
_Rzmge- Upto 100 miciers B
' Speed-up to 250 Kbps

B CANNETWORK |
Range- Upto 5 Kins

Speed- 40 K3/s TO 1 ME/s

Location- Used for shorter distance, controlied by 4 Locatiea- Larger than LAN, but smailer than
single person within a single MAN. University, school or small

building business, enterprise

Advantages- Efficient, Cost effective.Hotspot may Advantages- Cost effective ,Wired or Wired
connect upto 8 devices Network, High Bandwith

Dis-Adv- Shorter distance upto 10 meters only. Data Dis-Adv- Diffi cult to manage
rate is low compared to other
network

2. What is TCP/IP?

TCP- Transmission Control Protocol.a message to transmit and the means to reliably

transmit the message.

The internet protocol (IP) addressing system is used to keep track of the millions of users.

3. Write a note on Hotspot internet service.

Hotspots are sites that offer Internet access over a wireless local area network (WLAN) by way
of a router that then connects to an Internet service provider.

Hotspots utilize Wi-Fi technology, which allows electronic devices to connect to the Internet or
exchange data wirelessly through radio waves

4. Differentiate Data Card and Dongles.

Dongle Data Card
Refers to any removable component used for enabling | It is a removable electronic card which is used for
extra security. storing for data.
USB Dongles can be divided into Types of data card are
e WiFi Dongles e Expansion Card
e BlueTooth Dongle e Memory Card or Flash Card
e Memory Dongle ¢ Identification Card

5. Werite a note on two access methads of connecting to internet_Twao access
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methods there are:

Indirect Access

e This is most common method used in home and office networks.

e The device e.g. computer connects to a network using Ethernet or WiFi and Internet using
Asymmetric digital subscriber line ADSL( cable or fibre.)

Direct Access

e This is most common method used when travelling.

e The device e.g. smart phone connects directly to the Internet using 3G/4G mobile networks or
public Wi-Fi.

6. Differentiate browser and a search engine with suitable examples.

browser search engine
A browser is used to access websites and A search engine is a software system that
web pages whereas a search engine isused to search for | is designed to search for information on the
particular information World Wide Web.
Example:Internet Explorer, Chrome, Firefox, Safari, Examples of popular search engines are Yahoo,
etc. Google, etc.
A browser is used to access the Internet The list of content returned via a search
whereas in order to open a search engine you need a engine to a user is known as a search engine
browser results page (SERP).

7. Differentiate Website and Webpage.

Webpage Website

Consists of a Single document displayed by A collection of multiple documents
a browser displayable by a browser

Shares a uitique domain name Has its own unique domain aame
Makes up a vrebsite Contains one or more webpage:
8. What is the diffezence between Siatic and dynamic web page.

. StaticWebPage “Dynamic Web Page |
The content and iayoui of a web page is fixed The content and layout mey change duiiug
in | S Intime /L Lt /1 1 1
Static Web pages ncver use databascs Daiabases is uscd t¢ generate dynamic conteit
through queries
Static web pages directly run on the browser Dynamic web pages runs on the server
and do not require any server side side application programs and displays the
application program results
Static Web pages are easy to develop Dynamic web page development requires
programming skills

9. Write a note on W3C?
W3C stands for world wide web consortium.
It sets standards for the www to facilitate better communication ability. It
was established in 1994 by the creator of www, Tim Berners Lee.
10. What are Advantages of email.
The main advantages of email are listed below.
Free delivery - Sending an e-mail is virtually free, outside the cost of Internet service. There is no
need to buy a postage stamp to send a letter.
Global delivery - E-mail can be sent to nearly anywhere around the world, to any country.
Instant delivery - An e-mail can be instantly sent and received by the recipient over the Internet.
File attachment - An e-mail can include one or more file attachments, allowing a person to send
documents, pictures, or other files with an e-mail.
Long-term storage - E-mails are stored electronically, which allows for storage and archival over
long periods of time.
Environmentally friendly - Sending an e-mail does not require paper ( Paperless ),
cardboard, or packing tape, conserving paper resources.
PART IV
Answer to the following questions (5 Marks):
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G2G (Government to Government): When the exchange of information and services is

within the periphery of the government, is termed as G2G interaction.

1.e. between national, state and local government entities and within different levels of the entity.
G2C (Government to Citizen): The interaction amidst the government and general public is G2C
interaction. Here an interface is set up between government and citizens

G2B (Government to Business): In this case, the e-governance helps the business class to interact
with the government seamlessly. It aims at eliminating red-tapism, saving time, cost and establish
transparency in the business environment, while interacting with government.

G2E (Government to Employees): The government of any country is the biggest employer and
so it also deals with employees on a regular basis, as other employers do.

ICT helps in making the interaction between government and employees fast and efficient, along
with raising their level of satisfaction by providing perquisites and add-on benefits.
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1. Compare the different geographical types of Network.

Type of Network Range Speed Location Advantages Disadv
Local Area Network ( Re.fer.s to same office, same . Low Cost, Resource Sharing, Area Covered L1m1te.d When

LAN ) Upto 10 | Upto 10- building, same company and in Security number of nodes increases,

Km 100 Mbps same schools performance Decreases
Metropolitan Area 10 to Upto 5 — 2:1({[3;11;] dli{a/er;e;\;vglrllzi;ieezli%ned to Wider than LAN Data rate is slow compared to LAN
Network ( MAN ) 15 po Y tder than Cost higher than LAN
. 10 Mbps
Miles
I 1t Span . |
. Comniicated and Coriple<.High Cost.
. ‘ bove entirg . 't Span entir countries an< . Requires hiah
Wide Area Network ( countrie s | S Large geographical Area AN . | .
WAN 1000 — continent; Per{ormaincc Devices Lovs security.
) Kms . Ccst nigher tnan LAM
contiaents |
|| — /\_ /1 | Z\_IN /N L Il \_—/\ 1] |
P Aren Used for shorter _dlstance, Efﬁc1el.1t, Cost effective and Shorter distance upto 10 meters only.

Upto controlled by a single person convenient. Controlled by a :

Network up to 250 o ) ) A Data rate is low compared to other
100 within a single building single person Hotspot may

(PAN) Kbps . network
meters connect upto 8 devices

Campus Arca 40 KB/ Larger than LAN, but smaller Cost effective ,Wired or Wired
pus Are Upto 5 ¥ than MAN. University, school Network, High Bandwith Multi- .
Network TO 1 11 busi . d N K Difficult to manage
(CAN) Kms MB/s or small business, enterprise epartmental Network access
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Wireless Local Area
Network ( W-LAN )

Upto
50
Kms

1 Mbps to
54 Mbps

Ranges from a single room to an
entire campus Uses Wifi or
Bluetooth, Radio waves

Portable Installation is quick and
easy

Low Bandwidth due to
interference
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2. Explain any five types of internet services.
Any Five

Wireless
Radio frequency bands are used in place of telephone or cable networks. One of the greatest
advantages of wireless Internet connections is the "always-on" connection that can be accessed from
any location that falls within network coverage.
Mobile
Many cell phone and smartphone providers offer voice plans with Internet access. Mobile
Internet connections provide good speeds and allow you to access the Internet.
Hotspots
Hotspots are sites that offer Internet access over a wireless local area network (WLAN) by way
of a router that then connects to an Internet service provider.
Hotspots utilize Wi-Fi technology, which allows electronic devices to connect to the Internet or
exchange data wirelessly through radio waves.
Broadband
This high-speed Internet connection is provided through either cable or telephone companies. One
of the fastest options available, broadband Internet uses multiple data channels to send large
quantities of information. Broadband Internet connections such as DSL and cable are considered
high-bandwidth connections.
DSL
DSL, which stands for Digital Subscriber Line, uses existing 2-wire copper telephone line
connected to one's home so service is. Customers can still place calls while surfing the Internet.
Cable
Cable Internet connection is a foiin o7 kroadband access. Through usc of a cable modens, users can
access the Internet over cable TV lines. Cable modems can provide extremely fast access 10 the
Internet.
Satellite
In certain areas whzre broadband cormnection is not yei offered, ¢ satellite Internet ootion rray be
available. Similar ic wireless access, saielliie connecion utilizes a modem.
ISDN
ISDN (Integrated Services Digital Network) allows users to send data, voice and video content over
digital telephone lines or standard telephone wires. The installation of an ISDN
adapter is required at both ends of the transmission—on the part of the user as well as the Internet
access provider.

3. Explain any five internet applications with suitable examples. a

1. Internet telephony
Internet telephony (e.g. Skype) is another common communications service made possible by the
creation of the Internet. VoIP stands for Voice-over-Internet Protocol, referring to the protocol that
underlies all Internet communication.

2. Job search
Nowadays, many people search for their jobs online as it is quicker and there is a larger variety of
job vacancies present. People can publish resume online for prospective job. Some of the web sites
providing this service are naukri.com, monster.com, summerjob.com, recuritmentindia.com etc.

3. Online Shopping
The internet has also facilitated the introduction of a new market concept consisting of virtual
shops. They provide information about products or services for sale through www servers. Using
the internet services customers can submit specific product queries and request
specific sales quotes. For example amazon.com is a www based bookshop on the internet where
information on all types of international books can be found and books can be ordered online.

4. Stock market updates
Selling or buying shares sitting on computer through internet. Several websites like
ndtvprofit.com, moneypore.com, provide information regarding investment

5.T : ) - ) .
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One can use internet to gather information about various tourist place .it can be used for booking
Holiday tours, hotels, train, bus, flights and cabs. Some of the web sites providing this service are
goibibo.com, makemytrip.com, olacabs.com.

6. Research
Research papers are present online which helps in the researcher doing aliterature review

7. Video conferencing
It enables direct face-to-face communication across networks via web cameras,
microphones, and other communication tools.
Video conferencing can enable individuals in distant locations to participate in meetings on short
notice, with time and money savings.

8. e-commerce
e—commerce (electronic commerce or EC) is the buying and selling of goods and services, or the
transmitting of funds or data, over an electronic network, primarily the Internet.
Largest e-commerce companies in India are Flipkart, Snapdeal, Amazon India, Paytm.

9. Online payments
The rising boom of online payments in India has given way to many new entrants in the
industry such as Paytm etc who are majorly wallet driven payment companies.
This growth has been driven by rapid adoption led by the increasing use of smartphones, tablets
and speedy access to internet through broadband, 4G etc

10. Social Networking
Social networking is the use of internet-based social media programs to make connections with
friends, family, classmates, customers and clients.
Sociai netwerking can be done for social purposes, business purposes or both.
Examples of social networking inclucies Facebnok

1Ll. Voicemail

cormects you to the persort you want ©o leave a mzssage ror, and they can listen “o their messages
later.

122. Chatting
On the Internet, chatting is talking to other people who are using the Internet at the same time you
are.
Transcripts of a chat can be archived for later reference.

13. e-banking
e-banking (Online banking) , also known as internet banking, it is an electronic payment system that
enables customers of a bank or other financial institution to conduct a range of financial transactions
through the financial institution's website.

14. e-learning
e-Learning are courses that are specifically delivered via the internet to somewhere other than the
classroom where the professor is teaching. It is not a course delivered via a DVD or CD-ROM,
video tape or over a television channel
4. Write a note on any five Internet browsers other than that given in the book.an

Opera is smaller and faster than most other browsers, yet it is full- featured. Fast, user-friendly,
— with keyboard interface, multiple windows, zoom functions, and more. Java and non Java-

O enabled versions available. Ideal for newcomers to the Internet, school children, handicap and as

a front-end for CD-Rom and

kiosks.

Lynx is a fully-featured World Wide Web browser for users on Unix, VMS, and other platforms

running cursor-addressable, character-cell terminals or

emulators.

Chromium is an open-source Web browser project started by Google, to provide the source code
‘ far the nranrietarv (Gnnole Chrame hraweer 81 The twn
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L \UL

UC Browser is a web browser developed by the Chinese mobile Internet
company UCWeb, which is in turn owned by the Alibaba Group. As of August 2018 it is the
third most popular mobile browser in the world by market share,

after Google Chrome and Safari.

Netscape Navigator was a proprietary web browser, and the original browser of the Netscape
line, from versions 1 to 4.08, and 9.x. It was the flagship product of the Netscape
Communications Corp and was the dominant web browser in

terms of usage share in the 1990s, but by 2002 its use had almost disappeared.

Send Your Questions & Answer Keys to our email id - padasalai.net@gmail.com




www.Padasalai.Net www.TrbTnpsc.com

Familiar Internet Browser

eﬂ

Google Chrome is a freeware familiar web browser developed by Google Inc. It is best for its speed,
simplicity, security, privacy and customization features. Google Chrome supports on Android 4.0 or higher, i10S
6.0 or higher, Mac OSX 10.6 or higher and Windows (XP sp2 or higher) and Linux system.

| I

eﬂ Mozila Firefox is a free and open source web browser developed by Mozilla Foundationand
Mozilla Corporation. FireFox is default browser in Ubuntu . It supports Windows, Mac OS X, Linux and
Android system.

Internet Explorer commonly known as Microsoft Internet Explorer or Windows Internet Explorer is the
first or default browser for a Windows PC. It is developed by Microsoft.

ﬁ Safari is a web browser developed by Apple Inc. and comes with OS X and iOS. Some version of
safari browser also supports in Windows Operating System. Exclusively used in Apple Mac system.
5. Classify and explain any five e-commerce parties with suitable examples. Business to consumer (B2C)
— Transactions happen between businesses and consumers. In B2C ecommerce, businesses are the ones selling
products or services to end-users
Business to business (B2B) — As its name states, B2B ecommerce pertains to transactions conducted between
two businesses.
Any company whose customers are other businesses operate on a B2B model. Consumer to business
(C2B) — Consumer to business ecommerce happens when a consumer sells or contributes monetary
value to a business.
Many crowd sourcing campaigns fall under C2B ecommerce.
Consumer to consrziner (C2C) - As you might have guessed, C2C ccommerce happens when soniething is bcugiit
and sold between two consumers. C2C commionly takes nlace on online marketplaces suca as eBeay. in which one
individuai sells a product or service to another.
5. Government to business (G2B)— G2C rarsacuons teke place when 4 company pays for government goods,
se-vices, or fees or line.
6. Eusiness to goverument (B2G) — When a governm=m 2utity uses the Internet topurchases goods cr services
from a business, the transaction may fall under B2G ecommerce. Let’s say a city or town hires a web design firm to
update its website.
This type of deal may be considered a form of B2G.
7. Consumer to government (G2C) — Consumers can also engage in B2C ecommerce.People paying for traffic
tickets or paying for their car registration renewals online may fall under this category.
6. Explain the different types of interactions in e-governance.
G2G (Government to Government): When the exchange of information and services is within the
periphery of the government, is termed as G2G interaction.
i.e. between national, state and local government entities and within different levels of the entity.
G2C (Government to Citizen): The interaction amidst the government and general public is G2C interaction.
Here an interface is set up between government and citizensThe citizens has the freedom to share their views and
grievances on government policies anytime, anywhere.
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G2B (Government to Business): In this case, the e-governance helps the business class to
interact with the government seamlessly. It aims at eliminating red-tapism, saving time, cost and
establish transparency in the business environment, while interacting with government. G2E
(Government to Employees): The government of any country is the biggest employer and so it
also deals with employees on a regular basis, as other employers do.
ICT helps in making the interaction between government and employees fast and efficient,
along with raising their level of satisfaction by providing perquisites and add-on benefits.
Book Question

Define Host?

In Several networks are connected together and each computer on net is called as
host in network.
Define WWW?

The World Wide Web (WWW) is a network of online content that is formatted in HTML
and accessed via HTTP. The term refers to all the interlinked HTML pages that can be accessed
over the Internet. The World Wide Web was originally designed in 1991 by Tim Berners-Lee
while he was a contractor at CERN.

The World Wide Web is most often referred to simply as "the Web."
Define internet?

In Several networks, small and big all over the world, are connected together to form a
Global network called the internet.

Application area of internet

Online movies and gaming Instant messaging Internet forums
Social networking Online shopping Financial
services Data transfer/file-sharing, often through File Transfer Protocol (FTP)
Web-enabied audio/video conferenc ng services Email

Define Intiranet?
It is a website used by organizations tc provide a place wiiere erapioyees can access
ccmpany ielated information.
Define Extranet?
It is a private netvsork using interne! technology tc share pa-t of business inforrnation with
suppliers’ partners and custoiners.
What is Email?
Electronic mail or email is information stored on a computer that is exchanged between two users
over telecommunications. Email is a message that may contain text, files, images or any other
attachments sent through a network to a specified individual or group of individuals
The first mail was sent by Ray Tomlinson in 1971 as a test e-mailmessage containing the text
like “QWERTYUIOP”
What is URL?

A URL is an address that shows where a particular page can be found on the World
Wide Web. URL is an abbreviation for 'Uniform Resource Locator (URL)'.
What Domain Name?
It is a name or an identity which become a online identity and can be access by the web
browser when connected to internet.

Generic Domain Name Country Level Domain Name

Domain Description Domain Description
Name Name

.com Commercial Organisation Ain India

.govV Government institution -au Australia
org Non-profit Organisation .us United States of America
.net Network Support Group JP J apan
.edu Educational Institution Tu Russia
.Sg Singapore

What is the role of E-governance?
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E-governance has a great role to play, that improves and supports all tasks performed by

the government department andagencies, because it simplifies the task on the one hand and
increases the quality of work on the other.

Explain the Structure of email OR How will you a send a Mail

Click the Compose button and then writing an e-mail contents

When sending an e-mail message, several fields are required to be filled:

e The To field is where you type the e-mail address of the person who is the recipient of your message.

e The From field should contain your e-mail address.

e Ifyou are replying to a message, the To and From fields are automatically filled out; ifit's a new message,
you'll need to enter them manually.

e The Subject should consist of a few words describing the e-mail's contents. The Subject lets the
recipient see what the e-mail is about, without opening and reading the full e- mail. This field is
optional.

e The CC (Carbon Copy) field allows you to specify recipients who are not direct addressees
(listed in the "To" field). This field is optional.

e The BCC (Blind Carbon Copy) field is similar to CC, except the recipients are secret. Each BCC
recipient will receive the e-mail, but will not see who else received acopy.

e Finally, the Message Body is the location you type your main message. It often contains your signature
at the bottom; similar to a hand-written letter.

Safe Surfing on Internet
As a great reminder that Internet security is something that needs constant vigilance. It’s also a
great reminder that a lot of things can happen on the Internet if you don’t properly take
precautions against them. With that in mind, be sure to have a safe and happy Safer Internet
Day.
SAFER INTERNET DAY
Safer Internet Day (SID) 2018 is celebrated 2round the world in February of every vear with a
theme of "Create, connect and shate respect. A better iuternet staris with you".
Followiiig is the do’s aind don’t of safe Surfing on Internet
e Don’t give out your personal informatiozn
What goes online, stays
Check your security and nrivacy scttings
Password safety
Always protect your mobile device
Don’t talk to strangers online or offline
Listen to the adults who know
Be wary of unsecured or unknown websites
Be careful what links you click on

10. HTML - Structural Tags
SECTION-B

Answer to the following questions (2 Marks):

1 Sandhiya is creating a webpage. She is entering HTML code on her computer. In between,
she keeps pressing “Refersh” / “Reload” button on her browser. What is the purpose?
Reload / Refresh button is used to get the changes from the source file:
e After modify and save the source file, minimize your source file.
e Go to the browser.
o C(Click Refresh (Internet Explorer) / Reload Current Page (Firefox) / Reload this page (Chrome)
icons on the address bar.

e Press Ctrl + R or F5 will be used to refresh / reload the modifications.

2. Explain with the help of an example the difference between container and empty elements of
HTML.

Container Elements:

The tags which are required opening and closing is known as container elements or tags. For

example: html etc.,
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The tags which are required only opening tag is known as empty elements or tags. For example:

<br>,<hr> etc.,
3. What is the wrong in the following coding?

Wrong Correct
html]> <html>
my web page> <head> <title> my web page </title>
title> Welcome to my web page </head>
/head> <body>
Jtitle> Welcome to my web page
</body></html>

4. How do you define comments in HTML?
The tag <!> is used to create comments. In HTML, the text what you type within this tag is
considered as comments and it is ignored by the browser. Comments never show up onscreen.
Comments can be placed anywhere in HTML document.
The general form of comments:

<! comments >
5. How do you include an image as your web page background?
An image or picture can be applied as background to a webpage. When you insert an image as
background, the text will be displayed on top of the image. Background images can be a texture or
bitmap or even a photo.
The attributes to apply an image as background:
<body background = “image name with extenstion”>

SECTION-C
Answer to the follewing questicns (3 Marks):
1. Explaix the attributes available with <body> tag.
Attribuies of <hbody> tag
(i) Background Colour: bgcoler = celor
By defauit ali the biowseis display the text on wiiite bacikground. Ilowever, the backgound
color of the browser can be changed by using bgcolor tag.
The tag to change background colour:

<body bgcolor = color_name/color_code>

(ii) Body text Colour: text = color
The default text colour of body section is “ black”™, it is often called as automatic color. text

attribute within body tag is used to change the text colour.
The tag to change body text colour:
<body text = color name/ color code>

(iii) Background image: background=image

An image or picture can be applied as background to a webpage. When you insert an image as
background, the text will be displayed on top of the image. Background images can be a texture or
bitmap or even a photo.
The tag to apply an image as background:

<body background = “image name_ with_extenstion”>

If your image file name is long or split as two more words or along with path, should be
specify within double quotes.

For example, If the image file is somewhere in a folder (say Images folder in E: drive), you
must specify its full path within double quotes as given below.
Exmaple:

<body background = “E:\Images\ flower01.gif" >
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is no default margin setting in any browser. If you want to leave some space as margin to left or top;

leftmargin or topmargin attributes will be used respectively.
The tag to specify the left and top margin:
<body leftmargin = value topmargin = value>
The Value is referred as pixels (72 pixels to an inch)
2. What are the attributes available in <html> tags?
The <html> tag has two attributes viz. dir and lang to specify the text direction
and language setting respectively.

attribute Value to be set to Description
attribute
Dir Itr (align left-to-right) dir attribute specifies the direction of the text to be aligned
rtl (align right-to-left) within the entire document. It is global attribute.  Itr is the
default value
rtl is used for Arabian languages.
Lang Predefined language lang attribute specify the language used within the
code document. Predefined language code will be used for this
English — en purpose.
Tamil — ta Malayalam — ml; Kannada — kn; Hindi — hi; French
Telugu — te — fr; German — de;

3. How do you view the source file?
Viewing Source file
Source file is an HTML document, what you actually type in text editor ( Notepad or
gedit). You can view your original source file in the browser. The following steps are to be followed
to view a source file.
. Righit click on the browser
. Select View Page Source (Firefox and Chrome) / View Source (Internei Eplorer) or
Press Ctrl + U {all browser) Soarce fiie will be displayed.
In Internet Explorer, View -» Source is also used to open source file.
Remewber that, you canrot edit the source filc cpened using the methods ycu learnt above.
4. How do you save a file as HTML file?
To Save the file as i TML

Followed the Steps:
e Click File — Save (or) Press Ctrl + S
Save as dialog box appears
In “File Name” text box, type a file name with .htm or .html extension.
Select “All Files” from “Save as type” list box.
Click “Save” button.

Book Question
How do you open a file in a Browser?
Step 1: Open a Browser (Internet Explorer / Mozilla Firefox or any)
Step 2: Click File — Open File (or) Press Ctrl + O
* If menu bar is not visible in your browser
Step 3: From the “Open” dialog box, browse the folder in which the HTML document is saved.
Choose the File name and click “Open” button.
Now, your web page is displayed in the browser.
How do you edit a source file?
When you edit a source file, no need to close browser in which displaying the HTML
document. The following steps are to be followed to open a source file.
e Go to the folder in which your source files are located.
e According to you default browser, your source file icon is displayed.
e Right click on the source file that you want to edit
e From the pop-up menu, select Open With — Notepad
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Define Tags?

Tags are known as elements of HTML.

You cannot create your own tags to create a new style or feature.

All HTML tags should be specified within angle brackets (< >). Forexample,

<HTML> is a tag.

HTML is not case sensitive that means you can write an HTML tag in lower case or in upper case
(Small letter or Capital letter).

Browser treats both of them in the same manner. For example, you can write

<HTML> as <html>; both are same.

Opening and closing tags are the same name, but closing tag name preceded by a slash (/).

Define Attributes?

Attributes are special words used inside a tag to specify additional information to a tag.

Attributes should be placed within the opening tag. Most of the tags support specialized attributes
and there are also a few global elements that can be used with any tag. Global elements are

common to all HTML elements; they can be used on all elements.
What are Structural Tags of HTML:

Op;r;;g Cl%salgg Description
The <html> tag identified the document as an HTML
document.
< > < > . . .
! /html All HTML documents should begins with <html> and end with
</html>.
The <head> tag contains information about the document,
<hcau> | </head> | including its tit e, scripts used, style definition and document descriptions. |
__ . — | The (\titl-c/\—mgconiains the title of the document. [ ] =
<title> </title>

| | The title specified between opening and closing tags apyears in

<body> | </body> | information to be displayed in the web page.

i tae title bar / ITa ge tab of the browser. |
| <title> tag shouvld be placed within <head:> tag.

The <body™ tag encloses all the tags artributes and

<body> tag should be entered below the </head> tag.

How do you Creating a Webpage?
Creating a Webpage

Step 1

Step 2:

Step 3

: Open a text editor

Windows?7 : Start — All Programs —Accessories — Notepad Linux :
Applications — Accessories — Text Editor
In the appearing Note pad / Text Editor, type the HTML document.

: Save the file as HTML

Click File = Save (or) Press Ctrl +S

Save as dialog box appears

In “File Name” text box, type a file name with .htm or .html extension.
Select “All Files” from “Save as type” list box.

Click “Save” button.

How will you change color in HTML Documents?

HTML code, color name has been used to change the background color of the

browser’s body section.

There

are two way to specific color:

Using colour code(RGB)

RGB colors in HTML are represented as six digit hexadecimal values.
color code (hexadecimal value) will be more flexible to handle colors.
The six digit hexadecimal value is the combinations of three, two digit number sequence

represent a color. o ) )
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e Color code should be prefixed with #.

e First two digits represent Red, next two digits for Green and last two digits for Blue (RGB) in the
range of 00 — FF. For example, 000000 is black and FFFFFF is white. FFO000 is bright red.
Using colour name
e Colour name can be used for only few colors
e You can use some basic color names directly
Define heading Tags in HTML?
Headings are used to include titles to sections of a web page. HTML has six levels of
headings viz. <h1> to <h6>.
The number with h indicates the level of heading. Header tags are display the body text as
bolder and larger in size according to its level.
The syntax of heading tags:
<h...> Heading text </h...>
Align attribute is used in heading tags:to set right, center and justify alignment in Heading. Left is a
default alignment
The tag is to specify the alignment to headings:
<h# align = value>
NOTE: Where # is the level number in heading tag
Rule in browser application for displaying text?
Browser applications are having some special rules for displaying text. They do not recognize
returns, tabs or even more than one space between words.
If you create an HTML document with multiple lines of text, browser will display it as a
single line.
Define Line Breaks and Paragraphs Tag?
i. The <br> tag is used for line break. The <br> is an empty tag, does not F ave close tag and attribute.
It should be vlaced at the end of a line.
ii. Paregrephs are created using the <p>- tag. The content vwhat you type between
<p> and </p> is ideuuiied as a paragraph 2and display as a paragraph vy the browser. Because, the
browser does not vecognize returns (Pressing “Enter” Key). Remember that in word processors,
pressing “Enter” keyv 15 identitving 2 paragraph.

11. HTML - Formatting text, Creating Tables, List and Links
SECTION-B

Answer to the following questions (2 Marks):
1. Write a short note on (i) <strong> (ii) <em>
<strong> Important text
The <strong> tag is a phrase tag. It is used to define important text. This tag displays the text as
bold.
<em> - Emphasized text
The <em> tag is used to emphasize the text, the text will be in italics.
2. What is the use of <mark> tag?
Highlighting is an important formatting feature is used to call attention to the reader.
The <mark> tag is used to highlight the text in HTML. This is also a container tag.
3. Write the following equation as HTML notation: Pd = 25 - Q2
<Html> <head> <title>html notation</title>  </head>
<body>Pd=25 - Q2 </body>
</html>
4. Write about any two attributes of font tag.
e There are three main Attributes for Font tag
e The face is an attribute to set different font style. The name of a font has multiple
words it should be specified within double quote.
e The size attribute is used to set size of the text. The size can have an absolute value from 1
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e The color attribute is used to set the color to the text.

Note: The <font> tag is not supported by HTMLS5.

5. What is thematic break?( Book inside 5 Mark )
The <hr> (Horizontal Rules) tag, which is known as “Thematic Breaks” separate

sections of an HTML document visually.
It produces a horizontal line spread across the width of the browser. This is an empty
tag
6. What is pixel?
A pixel is one of the tiny dots that make up the display on computer. 72 pixels
equal to an inch. Pixel is usually referred as points.
For example: The code <hr size = 72> display a horizontal line with 1 inch
thickness. The default size is 3 pixels.
7. What are the types of list in HTML?
HTML supports three types of lists viz. numbered, unnumbered and definition. These
lists are called as Ordered List, Unordered List and Definition List respectively.
8. Howwillyoudefinenumberedlist?
Numbered List / Ordered List
e Numbered list is created within the tag pair <OL> ..... </OL> tag.
The tag <LI> is used to present the list item in the list.
Ordered list displays items in a numerical or alphabetical order.
Both <OL> and <LI> tags are container tags. closing tag </LI> never be used.

Attributes of Ordered List:
There are two attributes can be used to customize ordered list, they are
(1) Type - changing numbering style

(2) Start - changing numbering order.

1.~

Type — 1s used to chainge the number style. The default number style is standard Arabic numerals
(1,2,3,.ceennn ).
SECTION-C
Answer to the followinig questions {3 Marks):
1. Write an HTML code to display the following text in exactly the same way as given below.
<html><head><title> Html</title></head>
<body>
I am studying Computer Science Application.
</body</html>

2. Briefly explain the attributes of <hr> tag. Attributes
of <hr> tag (ANY 3)

The <hr> tag having four attributes viz. size, width, noshade and color. These attributes are
used to set size, width, 3D appearance and color to the horizontal line respectively.

Size: Thickness of the horizontal line can be changed with size attribute.
The size is given in terms of pixels. The default size is 3 pixels.
Width: The width attribute specifies the horizontal width of the rule line.

The default rule is drawn across the full width of the browser.
The value of the width attribute may be the exact width of the rule in pixel or a certain
percentage.
the value of the width is specified as percentage. 100% is the default width.

For example:
<hr width = 50%> display an half of a horizontal rule line on the browser window.
Noshade:  The default view of a horizontal rule line is 3D. So, no need to specify the
term “noshade” as an attribute with <hr> tag. If you specify the attribute “noshade” turn off
3D view, turns on 2D view. Noshade is a Boolean type attribute.
Color: The horizontal line is displayed in gray color by default. The color attribute

is used to claan&e is default color to desired color
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The general syntax of <hr> tag with attributes:

<hrsize=value width=value noshade, color=color_name/code> Note: All

attributes of <hr> tag is not supported by HTML5

3. What are the core tags used to create table in HTML?

There are five core tags are used to create a table in HTML. They are,

<table> tag is used to create a table.

<tr> tag defines table rows

<th> tag defined table columns

<td> tag is used to specify the data in a cell

<caption> tag defines title for the table

4. Write an HTML code to provide hyperlink to https://www.w3schools.com

<html><head><title> hyperlink </title></head>

<body>
<a href= “https://www.w3schools.com/index.html” > w3schools</a>
</body</html>
5. Difference between <UL> and <OL> tags.
<OL> tag <UL> tags
Ordered list displays items in a Ordered list displays items in a special bullet
numerical or alphabetical order. symbol
Unordered lists are often referred as Unordered lists are often referred as bulleted lists
numbered lists
To list item in <ul> using <li> To list item in <ol> using <li>

6. Write HTML code to produce the following table:
<table border=1 cellspacing=0 cellpadding=12>
<tr VAlign =top>
<td rowspan=2>A</td><td> B</td>
</tr>
<{r><ta> C</td>
</tr>
</table>
SECTION-D
Answer to the following questions (5 Marks):
1. Write an HTML code the show the following text: Program:
<html><head><title>table program</title></head>
<boby>
<center>MODERN ATOMIC THEORY </center>
<b>The findings of modern atomic theory are given as follows:</b>
<ul >
<li>An atom is the smallest particle which takes part in chemical reaction.
<li>An atom is considered to be a divisible particle.
<li>The atoms of the same element may not be similar in all respects.
<dI>
<dd>eg: Isotopes (<sub>17</sub>Cl<sup>35</sup>, <sub>17</sub>Cl<sup>37</sup>)
</dI> <hl>
<ul>
<li>The atoms of different elements may be similar in some respects.
<dI>
<dd>eg. Isobars (<sub>18</sub>Ar<sup>40</sup>, <sub>20</sub>Ca<sup>40</sup>)
</dI></ul>
</body>
</htmI>
2. Explain the attributes used with <table> tag in HTML. Attributes of
table (Any 3)
The <table> is a container tag. There are several attributes to improve the layout of the table.
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They are listed below:

1. Cellspacing: It is used to set the space between cells in a table. The value should be in pixels
2. Cellpadding: It is used to set the space between the contents of a cell and its border. the value
should be in pixels.

3. Border: Border attribute with <table> tag is used to specify the thickness ofthe border

lines around the table.

The value of the border attribute should be a non zero value in pixels. (displays the table
without border). The default value is Zero in most the browsers.

4.Bordercolor: It is used to apply the colour to the border lines.

5. Align: It is used to set the position of the table within the browser window. Left is the default
position. Right or center may be the value of align attribute.

6.BGecolor: It is used to apply background colour to the table.

7. Height and Width:

These two attributes are used to specify the height and width of a table in terms of

pixels or percentage.

3. Explain the types of list with suitable HTML code.
HTML supports three types of lists viz. numbered, unnumbered and definition.

These lists are called as Ordered List, Unordered List and Definition List respectively.
Numbered List / Ordered List

Numbered list is created within the tag pair <OL> ..... </OL> tag.

The tag <LI> is used to present the list item in the list.

Ordered list displays items in a numerical or alphabetical order.

Both <OL> and <LI> tags are container tags. closing tag </LI> never be used.

Attrbutes of Ordered List:
There are two aitributes can be used to customize erdered list, they are
(1) Tvpe - zhznging numbering style

'Type value iR | Numbering siyle Bl
1 | | Standard Arabic Nurerais 12,3,4,............... .. TSR
a | Lowercase letters a, b, ¢, d, covovereee. i
A Uppercase letter A,B,C,D ...........
i Lowercase Roman numerals i, ii, iii, iv, V ...............
I Uppercase Roman numerals I, IT, IIL, IV, V ........... (2) Start - changing

numbering order.
Type — is used to change the number style. The default number style is standard Arabic numerals
(1,2,3,0 e ).
Start — is used to specify the number of letter with which start the list. The default starting
point is 1.
Un-numbered List / Unordered List
e Unordered lists are often referred as bulleted lists. Instead of numbers,
e cach element in the list has prefixed with a special bullet symbol. Using<LI> tag
e Unordered list is surrounded within <UL> ......... </UL> tags

Attribute of Unordered List:
type attribute is used to customize bullet style for the list of elements. By default, a solid
circle is used as bullets.

Type value Numbering style
Disc e A solid circle
Square Tl A solid square
Circle o An unfilled circle
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Definition List

e Definition list is different from other two types of list. No bullet or number is provided for the
list items.
o The list element has two parts.
(1) A definition term (2) The definition description
e Definition list is surrounded within <DL>....... </DL> tags.
e Definition term is presented in between <DT>.....</DT> tagand
e Definition description should be surrounded within <DD>.......</DD> tag.
Example:
<htmlI> <head> <title> list in Html</title</head>
<body>
<ol type=A>
<li> hardware
<li> software
<ul>

<ul type= square>

<li> network

<li> mail

<hul>

<dI>

<dt> HTML

<dd> Hypertext markup Lanaguege</dI>
</body></himl>

4. What is Link aud explain the tvpes of links.

e Link is an important feature of HTML to connect web resources.

e Linkin HTML is used to create hyperlinks tc web content.

e Web contert may be an HTML document(internal) or an external webpzge or any
multimedia content such as an image, video, audio, animavion cte., o~ even a pait of the
current document.

There are two important things needs to create a link in HTML,

(1) The name of the file or URL to which you want to link

(2) The text that will serve as the clickable link.

The anchor tag <A> is used to create links along with HREF attribute. HREF is
abbreviated as “Hypertext Reference”.

Structure of an anchor tag with href:

<A href = Web content path / URL “> Text — Clickable link </A>
Example: <A href = "http://tnscert.org/index.htm]">SCERT </A>
5. Write HTML code to create the following table:

</table>

<table border=1 cellspacing=0 cellpadding=16>

<tr>

<td rowspan=3 VAlign=top>A</td>

<th colspan=4>B</th>

</tr>

<tr>

<td>C</td>

<td>D</td>

<td>E</td>

<td rowspan=2 VAlign=top>G</td>

</tr>

<tr>

<th colspan=3>F</th>
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</table>

Define Tables in HTML

Table is grid of rows and columns.
e The tables were officially introduced with HTML 3.2.
e Tables are useful for the general display of tabular data.
e Representing table in HTML is heavy on tags.
What other Tags used to create table elements
Apart from these five core tags, <tbody>, <thead> and <tfoot> tags are also used to
define and control whole sections of table.
All the above tags are container tags.
What are the Attributes of <TD>, <TH> and <TR> tags:
1. Align Used to specify the horizontal alignment of content within a cell. Left is the default
alignment. Possible values are Right and Center.
2. VAlign Used to specify the vertical alignment of the contents within a cell. Bottom is the
default alignment. Possible values are Top and Middle
3. Width Used to specify the width of a cell in terms of pixels or percentage.
4. BGcolor and Background
e Bgcolor attribute is used to apply a particular colour to the background of a cell.
e Background attribute is used to apply an image or picture as background of a cell.
5. Rowspan and Colspan

e Rowspan attribute is used to merge two or more cells in a row as a single cell.
e Colspan attribute is used to merge to two or more cells in a column as a single cell.

How to format the text in html
» Tormat the text such making bold, italic, underline, changing font style, font size, font color
and more.
»  Formatting text is very irnportan: as well as interesting task in creating web pages.
Formziting is purely based on your iinagination and creativity.
Define Nested Lists:
A list block can be defined inside ancther list is called as nested list.

What are the Comparison of :
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Final
Tag Usage Tag Usage Output
<b> | To show the text in bold <strong> To show important text Bold
<i> | To show the text as italics <em> To Call attention Italics
<u> To ShO.W thelgttas <ins> To insert a text Underline
underlined
<s> | To show the wrong text <del> To replaced or deleted text Strike
through
TAG NAME DESCRIPTION EXAMPLE
<strong> The tag is a phrase tag : <str
</strong> fmportant texg It is used to define important text. Welcomedy: Familnadu </st
<em> Rmphasized Tag is used to emphasize the text. Welcome to Tamilnadu <emr
</em> text
Tag is used to define the text bigger in
<big> BIG size than the normal size. Computer <bi
</big> It is often used to call attention a Computer (normal text) ¢
text
<§mal!_> Small ’ljag is used t'o define the text smaller than (;omputer (normal text) <smm
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A Subscript is a way to display a H<sut
<Sub> </Sub> Subscript character or a number below the normal  H>O <Sup>

line of type.

A Superscript is also a way to show a (atb)<
<Sup> </Sup> Superscript character or a number above the normal  (a+b)?

line of type.
<del></del> or Deleting Or Strike [Text will be displayed as strike through <s> Co
<s> </s> through i <del>
<ins> </ins> Inserting Text will be shown as underlined Computer <ins>
<Center> Center The tag is used to centralize a segment of Thiruvallur <cente
</center> text.

12. HTML - Adding multimedia elements and Forms
Part - 11

Answer to the following questions (2 Marks):
1. List out the popular image formats.
Most of the browsers supports, GIF, JPEG and PNG images formats
GIF (Graphical Interchange Format)
JPEG (Joint Photographic Experts Group)
PNG (Portable Network Graphics)
2. Write down the general format of marquee
General format:
<marquee> Text or iinage to be scroll </marquee>
3. What is inline sound or movie?
Music can be played in the background to a webpage, while the page is
viewcd. This is known as ‘inline’ sound or miovie..
4. What is the puipose of <input> tag”®
The purpose of <input> tag is to form controls, form controls are created by
using
<input> tag. The <input> is an empty tag used to create different form
elements or controls such as text box, radio buttons so on.
5. Which tag is used to specify the list of items in dropdown list box?
The <select> tag is used to create dropdown list box in HTML.
It provides a list of various options as a dropdown list
6. What are the major attributes are available in <textarea> tag? Define <textarea>

The <Textarea> tag used to receive multi line text data as input. Itis a
container tag.
The main attributes of <Textarea> are
Name — Used to define name to the control
Rows — Specifies the number of rows in the text area control
Cols — Specifies the number of columns in the text area. (number of characters in
a line)

Part — 111

Answer to the following questions (3 Marks):

1. Write a short note on familiar images format.
i. GIF (Graphical Interchange Format)

[ This format is one of the popular format for animated images.

[ It was developed by CompuServe.

[ This format is suitable for presenting tiny animated images, logos, icons,etc.,

[ It is not suitable for photographic work, because it uses maximum of 256 colours.
[ Animated GIF do not support sound or playback control.

ii. JPEG (Joint Photographic Experts Group) o ) )
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JPEG is the most popular image format supported by all web browsers.

[ This format is suitable for photographic images.

0 JPEG can include any number of colours.( supported Full color)

iii. PNG (Portable Network Graphics)

7 PNG is designed as a replacement for GIF.

[ Itis also supported by all browsers.

iv. SVG (Scalable Vector Graphics) ------ HTML-5 introduces SVG images.
SVG is a graphics format that was developed for web.

It was standardized by World Wide Web Consortium (W3C) in 2001.
All current web browsers supports basic features of SVG.

HOW will you scroll the text in HTML?

The HTML <marquee> tag is used for scrolling piece of text or image image can be moved
horizontally or vertically.This feature makes a web page as more attractive.

General format:
<marquee> Text or image to be scroll </marquee>

-1 + -
Attribgtesef Tmarquegr Description
behavior Scroll, slide, alternate L Usgto specify the type of scrpfiing:
[J To specify the direction of the movement of text or
direction Up, down, left, right image.
(Default is left) [J The text or image will move towards right to left by

default.

[ These attributes are used to set height and width of
the marquee.

[] Specifies how many times to loop. The default value

Height & Width pixels or %

loop number is INFINITE, which means that the marquee loops
endlessly.
scrolldelay | ~ Seconds(time unit) 0 0 Used to Defines time deldy “betvseen each JleJ————
scroilamount ! ~ number ! " Used to Defines the specd of the scroll ]
I 1 | — | 7 | — 1 ||
;;space & L pixels or % [ Specifies vertical space aroiund “he marquee.
Hspace | J IV T 7 | L 00 = R 0 I i A A i B I B A I I |

4. Explain the main attributes used with <form>tag.
Main Attributes used with <form> tag

The important attributes used with the <form> tag are method and action
attributes.
Method
The method attribute of the form tag is used to identify how the form element
names and values will be sent to the server.
The get method will append the names of the form elements and their values
to the URL. The post method will send the names and values of the form
elements as packets.
Action
The action attribute identifies the server side program or script that will
process the form. The action will be the name of a Common Gateway
Interface (CGI) program written in programming languages like Perl,
JavaScript, PHP or Active Server Pages (ASP).
General Format of <form> tag
<Form method=get/post action=
“back end server script’™ Form elements

</Form>
5. Explain the values of <input> tag’s type attribute.
Value of type Description
attribute
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Create a Text Box. The element used to get all kind of text input

Text such as name, address etc.,

Similar as Text box. But, while entering data, the characters are
Password . :

appearing as coded symbols such as asterisk.
Checkbox Check box is an element appearing like a small square box. When the

user click on the square a tiny tick mark will appear inside the
square. This element is used to select multiple options.

IRadio button is used to select any one of the multiple options from the
list. This element looks like a small circle, when the user select an
Radio Button litem, a tiny dot will appear within the circle. If the user selects
another option, previously selected option will be deselected. This
means, user can select any one of the given option form a group.
It is a special command button used to clear all the entries made in
the form.

It is also a special command button used to submit all the entries
made in the form to the backend server.

Button This is a standard graphical button on the form used
to call functions on click.

Multiselect box

Reset

Submit

6. Explain the attributes of <select> and <option>tags. or

Define select and Option tag? With its attributes

0 The <select> tag is used to create dropdown list box in HTML.

0 It provides a list of various options as a dropdown list.

0 This element is more helpful when a number of options are to be displayed in a limited
space.

[ The <option> tag is used to specify list items.

. Attributes of <Select> E g: Attributes of <1Etion> tag: ].
Name — Provide the name to the control, which is Selected — Indicate default selection |
sent 1o the scrver.

Size -- Determine uie style of dropdown ist Lox. Value — Vaiue to be subnritted to server
Size = 1 drepdown iist box

Size := 2 List box

I P SSEE————] W, i 4 | S = < A ) NN < A _\__1 A S W, LAY | L VS S SR W, G Ay | S —

How will you Inserting Images with HTML document or Define IMG tag.

The <IMG> tag along with the attribute src (Source) is used to add images in
HTML document. Images displayed on the web page should be converted to
universally supported format.

General format:

<img src = image name with extension> (OR) <img src = URL>
Note: If the image is not in the current working folder, the image file name should
clearly specify with the path of the file or URL, where the file is available.

Example: <img src = “D:\images\animals\cat.jpeg”>
Attributes of <img> tag:

Attributes of <img> tag: Description
The main attribute used to specify the file name of the image

to be inserted

IAlt (Alternative Text) Attribute used to describe the image

Attributes are used to set the width and height of an image.
The values pixels or percentage of its actual size.

Vspace (Vertical Space) & Attributes are used to set Vertical and Horizontal space
IHspace (Horizontal Space) between the images.

Src (Source)

'Width and Height
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The align attribute used to aligns the image with respect to

the base line of the text.
Bottom — Aligns the bottom of the image with the baseline of
Align the text. default setting.
Middle — Aligns the middle of the image with the baseline of
the text.
Top — Aligns the top of the image with the baseline of the text.
Left and Right values of  |Its displayed the image on the left and right side of the text.
lAlign attribute
Note: the browser displays the image in its original size. when attributes are not
specified
Example:
<img src =‘“bharathiyar.gif” alt ="National Poet of India" Width=20% Height=25%
vpace = 20 Hspace = 20>
How will you add Video and Audio into the Webpage
Video and Sound are the core part of the modern web pages.
[ A video or audio content may be included as Inline or external data.

Inline External
The inline refers to audio or video files are | The External refers linking external audio
handled as part of the page. or video files as url.

[ The <embed> tag is used to attach an audio or video file easily within
webpage.This<embed> tag includes the controls of the multimedia automatically in the
browser.

[ The <noembed> tag may be used as an alternate to display some other media file, in the case of
the browser does not support <embed> tag.

Attribute of <embed> tag
Src 1s the primary attribute used with <embed> tag.
The src attribute nsed to specify the naine of the media tile with its source location.
Other attribuics such as alt, height, width and align are used as it is used with ~img>.
General Format:

<embed src == audio / video file name with lccation> </embed>

How will insert sound or audio tiie into the html document?

Music can be played in the background to a webpage, while the page is
viewed. This is known as ‘inline’ sound or movie.

The <bgsound> tag is used to attach an inline sound file in HTML.
Attributes of < bgsound > tag:

The src attribute is used to define the location of the media

file. The Volume attribute used to adjust volume control.

The loop attribute defines the duration of play. The ‘infinite’ value causes
the audio play as long as the page is in view.
General Format: <bgsound src= “music file name with location”>
How will insert form into the html document?

[ The <form> tag is used to create a form.
0 An HTML from starts with <form> and ends with </form> tag.

[ Forms contain many types of form elements, such as text boxes, radio buttons, check boxes,
buttons and drop-down lists.

0 The form has a special element, which is submit button, which will submit the entries of a
form to a server application to process the entries.

[ The values they enter or select are passed with the name of the corresponding form
element to the Web server.

Attributes frequently used with <form> tag
The important attributes used with the <form> tag are method and action
attributes.
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Method

The method attribute of the form tag is used to identify how the form
element names The get method will append the names of the form elements
and their values to the URL. The post method will send the names and
values of the form elements as packets.

Action

The action attribute identifies the server side program or script that will process

the form. The action will be the name of a Common Gateway Interface (CGI)
General Format of <form> tag

<Form method=get/post action=

“back end server script”> Form elements
</Form>

Form Controls:

In HTML, there are different types of form controls are used to collect
data. They are Text box, Password, Checkbox, Radio buttons, Text area,
Select box, Submit and Reset Button.
<Input> Tag

Most of the form controls are created by using <input> tag. The <input>
1s an empty tag used to create different form elements or controls such as text
box, radio buttons so on.

Attributes of <input> tag:

Type: This attribute is used define the type of control to be created by <input>
tag. The values of type attribute are Text box. Password, Checkbox, Radio
but:ons, Text arca. Select bor, Submit and Reset Buttoi.

Naine: This attribute of <input> tag is used ic assign a name to the input controls.
The data values are passed to the server along with the names of the conatrols.
Value: This atiribute is used to define default value vo scme controls.

Size: This is uscd to set iiic width of the input text in terms o1 characters. it is
applicable only for textbox and password boxes.

Maxlength: This attribute of <input> tag is used to set the length of the input
character (number of characters to be inputted) to the textbox and password
boxes.

13 CSS - Cascading Style Sheets
Part - 11
Answer to the following questions (2 Marks):

1. What is the use of <style> tag?

A style tag is used to change the default characteristics of a particular tag in the
entire web document wherever that tag is used.

The <style> tag controls the presentation styles of a particular HTML document.
If you want to use a particular tag with the same style applied in one HTML document to
another is not possible.

Thus, the <style> tags are called as “Page-Level Styles” or “Internal Style sheets”.

2. What is CSS? Cascading Style Sheets (CSS)

[l CSS is a style sheet language used for describing the formatting of a document written in HTML.

[1  You can control the font colour, font style, spacing between pages, columns size, border colour,
background image or colour and various other effects in a web page.

3. Write the general format of linking CSS with HTML.

General format of <Link> tag
<Link rel = “stylesheet” type = “text/css” href = CSS File Name with Extension>
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href URL Specifies the location of the linked document

Specifies the relationship between the current document
and the linked document
type media type | Specifies the media type of the linked document
The "sizes" attribute is new in HTMLS
. What is Inline Style?
Inline style is used to define style for a particular tag anywhere in an HTML doc.
You can define styles for any tag within an HTML document.
But it is applicable only on that line where it is defined
. Write down general format of CSS declaration.
CSS - Style definition rules
The body of the style sheet consists of a series of rules.

rel stylesheet

0 O

9]

Selector Declaration
HTML Tag {Properties: Values; }
Part — II1

Answer to the following questions (3 Marks):
1. What are the advantages of using CSS? Advantages of
CSS
1. Maintainability -CSS are also defined and stored as separate files. So, the style and
appearance of a web page can be dynamically changed and maintain with less effort.
2. Reusability - The styles defined in CSS can be reused in multiple HTML pages.
3. Easy to understand - The tags in web pages are well organized with style specifications and
therefore it is easy to understand
. Write a short note on rule of CSS.
CSS style declaration consists of two major parts; Selector and Daclaration.
The Selector refers an HTML tag it which you want to apply styles.
The Declaration is a block o1 code contains style defiiition.
It should be surrounded by curly breces.
You can include any nurber of properties for each selector,
T'he property naine and its value should be separated by a coion.
Each declaration shculd bz terminated by a sernicolen ( ;).

N

-— W OO0

. Write a CSS fiie to define text coloer and aiignment to <p> tag.
Mystyle.css - CSS file
color:pink; Text-align : center;
} NOTE: Save the css file with extension .css

4. Write a CSS file to define font type, style and size to <h1> tag.
Mystyle.css - CSSfile
H1
{
Font-family : “Times New Roman”; Font-style : Italic; Font-size : 14px;
} NOTE: Save the css file with extension .css
Part-1V
Answer to the following questions (5 Marks):
1. Write an HTML document to display the following paragraph as per the given description Using CSS: ¢
Font Name : Cooper Black  Style : Bold Italics * Color : Blue “The State Institute of Education (SIE) was
established in 1965 to provide for systematic study of problems relating to School Education under the
administration of Directorate of School Education.”
<htmI>
<head><title> CSS DOCUMENT</title>
<style>
P
{
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</style>
<body>
<p>

] www.Padasalai.Net [
Font-family: “Cooper Black”; Font-style: Bold ; Font-weight: Italics; Color:

www.TrbTnpsc.com

lue;

The State Institute of Education (SIE) was established in 1965 to provide for systematic
study of problems relating to School Education under the administration of Directorate
of School Education.

</p>
</body>
</html>
2. List and explain the Font and text element properties and values used CSS
Formatting Properties Values Example
P
{
color:pink;
Text Colour | Color Predefined Color Name I}ﬂ
{
color : MediumSeaGreen;
}
P
Text Text-alion Center / Left / Right / {
Alignment & Justify Text-align : center;
L ] | ] ] |
P
/ N\ . a {
Font type Font-rarnily rout name | Foni-family : “Times New Rcman®;
- el B L1l —— NN — || ~— | |||
P
{
Font Style I'ont-style | Normal / Italic Font-family : “Times New Roman”;
Font-style : Italic;
}
Formatting Properties Values Example
P
{
Font Style ) Font-family : “Times New Roman”;
(Bold) Font-weight Normal / Bold Font-style : Ttalic;
Font-weight : bold;
}
P
{ . .
Font size Font-size Size in pixels Font-famiy Tlmes New Romagg
Font-style : Italic;
Font-size : 14px;
}
Body
Background | Background {
Colour Colour Predafinedl'Color_Name background-color : violet;
}
Border thickness
Border <space> border style I . ]
Colour Border <space>Predefined bord H2 { border : 2px solid red; }

erColor Name
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Body
Background— URL (“image name with { . « o
image A s background-image : url (“Flower.gif”);
extension”) |
Body
{
iac;l;%round- foresait background-image : url (“Flower.gif”);
Background P P background-repeat : norepeat;
Image }
Body
{
Background- . . background-image : url (“Flower.gif”);
osition Direction background-repeat : norepeat;
p background-position : right top;
}
Margin-top P
Margin- {
l;/?;?girjp h bottom Margin size in pixels Margin-top : 50px;
g Margin-left Margin-left : 50px;
Margin-right }

BOOK Question

Define internal and external style sheets?

Internal Style sheet or Page-Level Styles

External Style Sheets or Sitewide Style sheets

Its use the siyle to single page

Its use the same style to multiple pages

Define within the htm! doc

| Separate style file (extension with .css)

Prcfessional web deveiopars tse exterral
| sty es.

- . B
| INo Separate tag is used

Method of creating CSS style sheets Creating CSS

stvle sheets:
e Open an empty notepad.

e Type the style properties and their values as given in the table given above.

e Save the file with extension .css
Define CSS Comments

you may need to put additional comments in your style sheet blocks. So, it is very

easy to comment any part in style sheet.

You can simply put your comments inside /*.....this is a comment in style sheet.....*/.

14 Introduction to Javascript

Answer to the following questions (2 Marks):
1. Write a syntax of <script> tag

Part-II

The syntax of JavaScript segment in Hyper Text Markup Language (HTML) or Dynamic
Hyper Text Markup Language (DHTML) is as follows:
<script language="javascript" type="text/javascript"> JavaScript

code
</script>

2. What is scope of variables and types of scope variable?
The scope of a variable is the life time of a variable of source code in which it is defined.
Global: A global variable has global scope; it can be defined everywhere in the JavaScript

code.

Local: Variables declared within a function are defined only within the body of the
function. They are local variables and have local scope.{ }

3. Write §1 notes to e casting in JavaScri

ipt - . .
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Type conversion is the act of converting one data type into a different data type which is

also called as casting. In JavaScript there are two type of casting,
Implicit casting and Explicit casting

Implicit casting occurs automatically in JavaScript when you change the data stored in a
variable
4. How many Literals in JavaScript and mention its types. Literals
e A literal is a fixed value given to a variable in source code.
e Literals are often used to initialize variables.
e Values may be Integer, Floating point, Character, String and Boolean. For Example,
var int_const=250; //Integer constant//
var float _const=250.85; //Floating point constant//
var char_const="A’; /Character constant//
var string_const="Raman”; //String constant//

e var boolean_const=true; /Boolean constant// write
statement: Display Statement
General Syntax: Document.write ("string " + var);
5. What is conditional operator give suitable example.
The ?: is the conditional operator in JavaScript, which requires three operands, hence it is
called the ternary operator.
The syntax is var variablename=(condition) ? valuel : value2;
For example, var result=(10>15) ?100 :150;
6. What are the comments in Java Script?
There are two types of comments, Single line and Multiple lines comments.
Single-line comments begin with a double slash (//), causing the interpreter to ignore

Mu'iipic line comments begins with /* and ends with */.
7. Write nate on typesof Operator. rzturns che data type
[J The typeof operator is used o get the data type ‘returns a sirirg) of its operand.
[0 The operand can ve cither a literal or a data siructure such as a vaiiavie, a function, ci an object.
[0 The operator returns th2 data type.
Syntax: typeof eperand or typeof(operand)

O typeof returns: boelean, function, rumber, string, 2nd nndctined
8. Write the role of variable in JavaScript.
e The first character must be a letter or an underscore (_). Number cannot be as the first character.
e The rest of the variable name can include any letter, any number, or the underscore.

JavaScript variable names are case sensitive. That is,

a variable named RegNum is different variable than named regnum.
e There is no limit to the length of the variable name.
e JavaScript's reserved words cannot be used as a variable name.
9. What is the uses of prompt dialog box?
The prompt dialog box is very useful when the user want to pop-up a text box to get user
input. It enables you to interact with the user.
The user needs to fill in the text box field and then click OK.

Part-III Answer to
the following question (3 Marks):

1. What are the advantages of programming language?
e To develop such interactive pages (Dynamic Web page) JavaScript programming

language is used.
e User entered data in the Dynamic Web page can be validated before sending it to the server.
e This saves server traffic, which means less load on your server.
e JavaScript includes such items as Textboxes, Buttons, drag-and-drop etc, to give a Rich Interface

to site visitors.
2. Brief the basic data types in Java Scripts.
The basic data types in JavaScript are Strings, Numbers, and Booleans.

String:
e string is a list of characters
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e a string literal is indicated by enclosing the characters in single(single character) or double

quotes (multiple characters).
¢ including whitespace and special characters such as \n (the newline).
Numbers:
e Number can be integer or floating-point numerical value and numeric literals are
specified in the natural way.
Boolean
e Boolean can be any one of two values: true or false.
e Boolean literals are indicated by using true or false directly in the source code.
3. Write note on string Operator.
e One of the built-in features of JavaScript is the ability to concatenate strings.
e The + operator performs addition on numbers but also serves as the concatenation operator
for strings.
e + operator which is also called as the string concatenation operator
4. Write about <script> tag
[J JavaScript can be implemented using <script>... </script> tags.
[J The <script> tag containing JavaScript can be placed anywhere within in the web page, but it is
normally recommended that should be kept it within the <head> tags.
[1 The <script> tag alerts the browser program to start interpreting all the text between these tags as a
script commands

The syntax of JavaScript segment in Hyper Text Markup Language (HTML) or
Dynamic Hyper Text Markup Language (DHTML) is as follows:

<script language="javascript" type="text/javascript"> JavaScript

code
</script>
The <<SCRIPT> tag takes two important attributes —
Language — This attribute speciiies that the scripting laniguage. Typically, its vaiue will be
javascript. Although recent versions of HTML (EXtensible HyperText Markup Language -
XHTML  iis successor) have phased out ihe use of this attribuie 1s optional.
Type — This a:tribute is used to inclicate the scripting language and its value should be
set to "text/javascript'.
5. What are the uses of Logical Operators?
e Logical operators combine or invert boolean values.

e Once comparisons are made, the logical operators && (AND), || (OR) and ! (NOT) can be used to
create more complex conditions.Use logical operators on boolean operands for good practice.
6. Difference between the increment and Decrement operator.

Increment operator Decrement operator
The ++ operator increments its single The -- operator decrements its single
operand. operand
Its converts its operand to a number, adds 1 Its converts its operand to a number,
to that number, and assigns the incremented value | subtracts 1 to that number, and assigns the
back into the Operand decremented value back into the operand
Post increment: var m=3, n=m++; Post decrement: var m=3, n=m--;
Pre increment: var m=3, n=++; Pre decrement: var m=3, n=m--;

Part -1V Answer
to the following questions (5 Marks):
1. Explain about the popup dialog boxes in JavaScript.
JavaScript supports three kind of popup boxes: 1. Alert box 2. Confirm box 3.Prompt
box. These dialog boxes can be used to raise an alert, or to get confirmation on any
input or to have a kind of input from the users.

1. Alert Dialog Box:
An alert dialog box is mostly used to give a warning message to the users.

For example, Some fields are incomplete in form, then as a part of validation, you can
use an alert box to give a warning message.

: ” ”"”
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The syntax of alert box is

Alert(“Message™); (or) Window.alert(“Message™);
Example:
alert(“Name is compulsory entry”); (or) window.alert(“Name is compulsory entry”);
2. Confirm Dialog Box:
A confirmation dialog box is mostly used to take user's consent on any
option. It displays a dialog box with two buttons: OK and Cancel.
If the user clicks on the OK button, the confirm() will return true.
If the user clicks on the Cancel button, then confirm() returns false.
The syntax of confirm dialog box is confirm(“message™); (or)
window.confirm(“message”); Example:
confirm(“Do you want to continue:”); (or) window.confirm(“Do you want to continue:”);
3. Prompt Dialog Box:
The prompt dialog box is very useful when the user want to pop-up a text box to get user
input. Thus, it enables you to interact with the user.
The user needs to fill in the text box field and then click OK.
The prompt dialog box is displayed using a method called prompt() which takes two
parameters:
(i) a label which you want to display in the text box and
(ii) a default string to display in the text box.
This dialog box has two buttons:
OK and Cancel.
If the user clicks the OK button, it will return the entered value from the text
box. If the user clicks the Cancel button, it returns null.

The Syntax of prompt dialog box is,
Prompt(“Messc.ge”,”defaultValve”): (or) windew.prompt("sometext"," defaultText"); Examypie:
prompt(“Eater Your Name:”,”Narme”); {or) wir dcw.prowupt(“Enter Y our Namc:”,”Naime”);
2. Explain abgat the Arithmetic operator with suitable exampie.
JavaScript supports all the basic arithmetic operavors like additior (+), subtraction (—
), multiplication {*), division (/). and modulus (%, also known as the rernainder cperator).

Arithmetic ey D e - D Ol
Operator Meaning Example Result
+ IAddition var sum = 20 + 120 Variable sum = 140
- Subtraction var diff =20 — 120 'Variable diff = 100
* Multiplication var prod = 10 * 100 'Variable prod = 1000
/ Division var res = 100/522 'Variable res = 5.22
% Modulus operator var rem = 100 % 522 Variable rem = 22 (remainder)
Example:
<Html>
<Head>

<Title>Demo Program — To test Arithmetic Operators in JavaScript </Title>

</Head>

<Body>

<script language="javascript" type="text/javascript">

var valuel = 522, value2=10;

document.write("<br>Datal : "+valuel);

document.write("<br>Data2 : "+value2);

document.write("<br><br>The Sum of Datal and Data2 : " var sum = valuel+value2);
document.write("<br>The Difference of Datal and Data2 : " var diff = valuel-value2);
document.write("<br>The Product of Datal and Data2 : " var prod = valuel*value2);
document.write("<br>The Result after Division of Datal and Data2 : "var res =

Valuel/v%%&%ﬁour Questions & Answer Keys to our email id - padasalai.net@gmail.com
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document.write("<br>The Remainder after Division of Datal and Data2 : "var rem =

valuel%value2);
</script>
</Body>
</Html>
Book Question

Define JavaScript?
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It provides a common scripting language for Web developers to design, test and deploy
Internet Applications.

On December 4, 1995, Netscape and Sun Inc.

jointly introduced JavaScript 1.0. JavaScript had truly bridged the gap between the simple
world of HTML and the more complex Common Gateway Interface (CGI) programs on the
Server.

The JavaScript client-side technology provides many advantages over traditional CGI
Server-side scripts.

List out the types of Operator.

[

OO

[

Arithmetic Operators Assignment

Operator Relational or Comparison Operators Logical

Operators

String Operators (string concatenation) Increment and Decrement
Operators Unary + and — Operator typeof Operator

Conditional Operator(?:)
Define Interpreter in JavaScript?
e In JavaScript the source code are understand by a program name interpreter
e Its used to convert the code into understandable
form Write down the Steps to create JavaScript
Language Enter HTML and JavaScript code using any
text editor.
e Save the latest version of this code.
e Use any browser to see the result. For example : Internet Explorer, Googl: Crome. etc.,
e Open tle file via browser's Co>n Men.
e Ifthe document is alreacy loacec in the Memory, to reload the file into the browser use
"Reiresh" or press 55 button.
Define Variable.
e Variable is a mieincry location where vaive can be stored.
e Variable is a symbolic name for a value.
e Variables are declared with the var keyword in JavaScript.

e Every variable has a name, called identifier.

e multiple variables can be declared with one var statement, if the variables are separated
by commas

e JavaScript allows the implicit declaration of variables by using them on the left-hand side
of an assignment

Define Operators And Expression
Operator: An operator combines the values of its operands in some way and
evaluates to a new value. Operators are used for JavaScript’s arithmetic
expressions, comparison expressions, logical expressions, assignment expressions.
Expression: An expression is a code fragment that can be evaluated to some data
type the language supports. An expression is simply one or more variables and/or
constants joined by operators.
There are three types of expressions
1. Arithmetic expressions 2.Relational expressions 3.Logical expressions
Explain assignment operator(=)
An assignment operator is the operator used to assign a new value to a variable.
Assignment operator can also be used for logical operations such as bitwise logical

Page
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operations or operations on integral operands and Boolean operands.

In JavaScript = is an assignment operator, Assign value from “right to left”
Example: var number1=10;

The assignment operator is used to assign a value to a single variable, but it is
possible to perform multiple assignments at once by stringing them together with
the = operator Example: var b=c=8; value 8 is assign to ¢ and value of c is assign to
b

JavaScript supports some shorthand arithmetic operators like +=, -=, *=, /= and

%= to evaluate arithmetic calculations. (Compound Assignment Operator)

Shorthand

Arithmetic Meaning Example Result
Operator

+= IAdd and assign var sum = 120; sum += 20; Variable sum = 140

= Subtract and assign var diff = 120; diff —= 20; Variable diff = 100

*= Multiply and assign var prod = 100; prod *=10; Variable prod = 1000

/= Division Var res = 522; Res/=100 Variable res = 5.22

%= Modulus operator Var rem = 522; Variable rem = 22

rem %= 100 (remainder)

Explain Relational or Comparison Operators?
Relational operators are also cailed as Comparison operators, they compares two
vaiues and the result is true or fzlse.

JavaScript provides a rich <et of relational operators.
Using = relauonal operator in an expression causes the cxpression -0 evaiuate as
truc if the condition helcs or false it otherwise.

Relational Operator Meauing Example Result
AN \ NAA L \ NN TN / N\ A | L INN AN |

Assume x=19¢ and y=20

== Equality X==y False

1= In-equality x!=y True

< Less-than X<y True

> Greater-than x>y False

<= Less-than or equal to x<=y True

>= Greater-than or equal to x>=y False

Explain Logical Operators?
Logical operators perform logical (boolean) operations. Logical operators combine
or invert boolean values.
used to create more complex conditions.

Logical Example & K

Ope%ator Syantag Meaning Result

&& ((4>5(&& )10<5)) (Logical AND) Returns true if exprl and expr2 | True
((exprl) && (expr2)) both true.

|| ((4>5(]] )10<5)) (Logical OR) Returns true if either exprl or True
((exprl) || (expr2)) expr? is true, or both are true.

! 1(10<5) (Logical NOT) Returns true if exprl is false; False
!(exprl) otherwise, returns false. -

Usage : Tes

Best practice is to use logical operators on boolean operands. However, operands of
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‘any type can be combined. The strict rules are as follows:

For && (AND) the result is false if the first operand is false; otherwise, the result is the
Boolean value of the second operand.

For || (OR) the result is true if the first operand is true; otherwise, the result is the
Boolean value of the second operand.

For ! (NOT) the result is true if the operand is false; otherwise, the result is true.

Define Unary + and - Operator?
+ has no effect on numbers but causes non-numbers to be converted into numbers
Note: if the value is in string convert it into number
— Negation (changes the sign of the number or converts the expression to a number and then
changes its sign)
Note: if the value is opposite change to negative and if value is in string
convert it into integer and change the sign

Defme Lexical Structure?

The lexical structure of a programming language is the set of elementary rules that
specifies how to write programs in that language.

It is the lowest-level syntax of a language.

Lexical structure specifies variable names, the delimiter characters for comments, and
how one program statement is separated from the next.

There are

O

O

Though JavaScript is a case-sensitive language. It is good programming dractice to type
the command in lowercase.

JavaScript ignoires spaces that eppear between tokens (identifiers, operators, puuctuator,
constanis ana key'words) in prcgrams.

JavaScript supports two styles of comiments. Any text icllow a *“/”” and the end of 2 line is
treated as a single line comment and is ignored by JavaScript. Any text tetween the
characters “ /* */” ic also treated as a muitline comment.

JavaScript uses the semicoion (;) to separate statements. Many JavaScript programmers
use semicolons to explicitly mark the ends of statements.

A literal is a data value for variable that appears directly in a program.

An identifier is simply a name. In JavaScript, identifiers are used to name variables,
functions and to provide labels for certain loops in JavaScript code.

In JavaScript certain keywords are used as reserved words, These words cannot used as
identifiers in the programs

15 Control Structure in JavaScript
P
art - II Answer to the following questions
(2 Marks):

1. What are the different types of control statement used in JavaScript?

There are two types of controls,

1. Branching / Selection 2. Looping / repetitive

2. What is meant by conditional statements in JavaScript?

Statements are executed in the order they are found in a script.

Conditional statements execute or skip one or set of statements depending on the
value of a specified conditional expression.

3. List out the various branching statements in JavaScript?

There are different branching statements. They are,
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if statement (Single way branch) if ... else statement (Two way
branch)

switch statement (Multi way branch) else if statement (Two way branch)
4. Write the general syntax for switch statement

switch(expression)

{

case labell: statements] ; break;

case label2: statements2; break;

case labeln; statements - N; break; default: (optional)

statements;

}

5. Differentiate the break and continue statement.

break statement continue statement
The break statement will terminate the loop The continue statement will skip back to the
Early loop condition check.

JavaScript also supports statements used to modify flow control

Part
- IIT Answer te the tollowing questions (3 Maiks):
1. What is if statement and write its types.
Thc if statenient is the fundamental centrol statemeit that allows JavaScript to
make decisions to executie stateraents conditionally.
This statement ni2s two foruus. The forn 1s 1or oniy true condition.

The syntax is Types of if statement

if (condition) if else statement

{ else if statement
True block; nested if statement

}

2. Write the syntax for else-if statement.
if (Condition 1)

{ block
I, }else
if
(condition
2)

{ block
2; }else
if
(condition
3)

{ Page
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ck 3; }else
{ Dblock 4; }
3. What is called a loop and what are its types?

In JavaScript there are times when the same portion of code needs to be
executed many times with slightly different values is called Loops. .
JavaScript supports three kinds of looping statements. Main three types
They are for loop ,while loop and do..while loop
Two categories are entry check and exit check

4. Differentiate between while and do while statements

while statements do while statements
first condition will be evaluated and then only based |do..while loop body of the loop always executed
on the result of the condition the body at least once before the condition
of the loop will be executed or not can be executed
Entry check loop Exit check loop
Checking and execution time of loop is differ Checking and execution time of loop is
in while loop same in do while loop

5. What message will be displayed, if the input for age is given as 20, for the following snippet.
Message will be display like
you are eligible to get Driving licence
Part - IV Answer to the follo*ving
guestions (5 Marks):
1. Explain for J5op with exampie
e The for loow is a very rigid structure that loops for a prz-set number of tirnes.
e In JavaScript foi structure is very flexisic, which niakes this type is very useful
The syntax:
for(initialization; cendition; increment/decrement)
{
Body of the loop;
j
The for structure within parenthesis there are three parts each separated by
semicolon ;. They are,
e The first part of the loop initialize a variable which is also called as control variable.
e The second part is the conditional statement that determines how many times the loop
will be iterated (executed).
e The third and final part determines how the value of control variable is changed
(Incremented/Decremented)
Example:
for (var x=0;x<3;x++)
{ document.write(x+ “<br>"); }
2. Explain switch case statement with example
e JavaScripts offers the switch statement as an alternate to using if...else structure.
e The switch statement is especially useful when testing all the possible results of an
expression.
The syntax of a switch structure as the following:

switch(expression)

{

Page
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case labell: statements] ; break;

case label2: statements?2; break;

case labeln; statements - N; break; default: (optional)
statements;

J

The default structure is can be at the end of a switch structure if the result of the
expression that do not match any of the case labels.

Ex

am

ple

var

ch

5

SW

itc

h(c

h)

{

case 1: document.write("Your Grade is Outstanding..");

break; case 2: document.write("Your Gradeis
default: decument.write(" Your Grade Poor and have s re-appear Exam..");

j

3- Write¢ the sutput for the following

p rOgram OU‘tput: Eplo ';’-—Jser Prom; \ [ | n _@J
Multiplication for your need e A\ S\ — / (N /\ T | oA,
SXOZO Script Prompt- ce

5X 1 :5 please enter table you want: m
5x2=10 z
5x3=15 '
5x4=20
5x5=25
5x6=30
5x7=35
5x8=40
5x9=45
5x10=50
4. Write a Java Script program using while statement to display 10 numbers.

<Html>

<Head> <Title>Program - To test while statement in JavaScript </Title> </Head>
<Body>

<script language="javascript"

type="text/javascript">

document.write("<h2>Using while Statement

</h2>"); var no2=0; Page
while(no2<10) OUTPUT:
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{ 0123456789
document.write(n
02+"");

no2=no2+1;

J

</script>

</Body>

</Html>

Explain Branching Statements with types

JavaScript supports branching statements which are used to perform different
actions based on different conditions.

Branching is a transfer of control from the current statement to another statement
or construct in the program unit.

A branch alters the execution sequence

16 JavaScript Functions
Part-II Answer to the following questions (2
Marks):
1. What is a function in JavaScript?
A function is a block of JavaScript code that is defined once but may be executed or
invokea any numcer of tiines. Functions are uscd e encapsulate code that peirforms a
specific task.
2. What is the use of function?
Function is used to keep code that performs a particular job in one place in order to enhance
reusability and program clavity.
3. Write a note ci1 Library fuanctions.
Pre-defined functions are already defined in the JavaScript library which are also
called Library functions. For example toUpperCase(), toLowerCase() etc., are pre-
defined functions.
4. Write a note on user defined functions.
User-defined functions allow the programmer to modularize a
program. This eliminates the need of writing the same code
again and again.
5. Write the syntax of functions.
Function function-name(parameters list)
{
Function Body ;
} Note: Function body include Declaration of variable and Executable statements.
Part II1
Answer to the following questions (3 Marks):
1. Write a program in JavaScript to find the cube of a number using function
<html>
<body>
<script language="javascript" Page
type="text/javascript"> var n=prompt("enter
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value:","0");

var c=cube(n);

document.writeln("the value is "+n+" the cube of given value is

"+c); function cube(x)

{

var c=x*x*x; return c;

|

</script>

</body>

</html>
2. Write a program in JavaScript to find the sum of 10 numbers using function.

<htmI>

<head>

<title>Javascript</title>

<script language="javascript"
type="‘text/javascript”> var
n=9,sum=0,tot=add(n);

function add(j)
{
for (vari=0;1<=j; it++)
fosum +=
1; 'return
suin;
} docnment.write('result"+sum);
</script>
</head>
<body>
</body>
</html>
Function Description Example Result
toUpperCase() Used to convert given string into x="java” JAVA
uppercase x.toUpperCase();
toLowerCase() Used to convert given string into x="JAVA” java
lowercase x.toLowerCase();
Note: If first character of the string is not a Number then it returns NaN
Length() Used to find length of the given x="JAVA” 4
string x.length();
parselnt() Used t.o conve_trt the given float parselnt(34.234): 34
value into an integer
parseFloat() the sj[ring apd convert it into a parseFloat(*34.23”); 34.23
floating point
etElementByld Method returns the element
¢ Y0 that has the ID attribute with the getElementB?'/Id("my
specified value. Quiz”) Pag
Note: elements[0] indicates the first option given in the question
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Define isNan()? means (is Not A Number)
The isNaN() function is used to check whether the given value or variable is valid
number. This function returns true if the given value is not a number.
For example isNaN(“12”), isNaN(“A”).

Page
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17 COMPUTER ETHICS AND CYBER SECURITY
Part 11
Answer to the following questions (2 Marks):
1. What is harvesting?

A person or program collects login and password information
from a legitimate user to illegally gain access to others’ account(s).
2. What are Warez?

Commercial programs that are made available to the public
illegally are often called warez.

3. Write a short note on cracking.

Cracking is where someone edits a program source so that the code
can be exploited or modified. A cracker (also called a black hat or dark
side hacker) is a malicious or criminal hacker.

4. Write two types of cyber attacks.

Malware is a type of software designed through which the criminals
gain illegal access to software and cause damage.

Types: 1. Virus, 2.Worms, 3.Spyware, 4. Ransomware

5. Whatis a Cookie?

A cookie is a small piece of data sent from a websitz and stored
on the user's computer niemory (Hard drive) by the user's web browser
while the user is browsing internet.

Type of cookies;: HTTP cookie, ekl coorie, Internec cooxie, hrowser
cookie, or simply cookie

Pact III
Answer to the following questions (3 Mar'ks):
1. What is the role of firewalls?{ layered security)

Firewalls also vary in type deneuiding on where coramunication
originates, where it is intercepted, and the state of communication
being traced.

2. Write about encryption and decryption.

Encryption and decryption are processes that ensure
confidentiality that only authorized persons can access the
information.

Encryption is the process of translating the plain text data
(plaintext) into random and mangled data (called cipher-text).

Decryption reverse process of converting the cipher-text back to
plaintext.

Encryption and decryption are done by cryptography
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3. Explain symmetric key encryption.

Symmetric encryption is a technique to use the same key for
both encryption and decryption.

(Secret key)To exchange the key used to encrypt the data before
they can decrypt it
4. What are the guidelines to be followed by any computer user?

e Honesty: Users should be truthful while using the internet.

¢ Confidentiality: Users should not share any important information
with unauthorized people.

¢ Respect: Each user should respect the privacy of other users.

¢ Professionalism: Each user should maintain professional conduct.

¢ Obey The Law: Users should strictly obey the cyber law in computer
usage.

¢ Responsibility: Each user should take ownership and responsibility
for their actions

5. What are ethical issues? Name some.

An Ethical issue is a prob.em or issue that recuires a person or
organization to choose between alternatives that must be evaluated as
right {cthical) or wicng (unethical).

These issizes must be add-essed and resolved to have a positive
influence in scciety.

Sonie of the cemnion cthical issues 2r¢ listed below:

CyLer crime Use of computers to commilt fraud
Software Piracy Sabotige in the forra of virtses
Unauthorized Access Making false clairas using coniputers
1Tacking

Part IV
Answer to the following questions (5 Marks):
1. What are the various crimes happening using computer?

Crime Function
Crime Hacking, threats, and blackmailing towards a
Function business or a person.

Cyber stalking | Harassing through online.
Malicious programs that can perform a variety
of functions including stealing, encrypting or

Malware deleting sensitive data, monitoring user’s
computer activity without their permission.
Denial of Overloading a system with fake requests so

requests.
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Manipulating data, for example changing the

Fraud banking records to transfer money to an
unauthorized account.
A person or program collects login and
Harvesting password information from a legitimate user to
illegally gain access to others’ account(s).
. It is a crime where the criminals impersonate
Identity theft individuals, usually for financial gailil.
Intellectual Stealing practical or conceptual information
property theft | developed by another person or company.

Salami slicing

Stealing tiny amounts of money from each
transaction.

Tricking people into believing something that

Scam .
1S not true.
Distribute unwanted e-mail to a large number
Spam .
of internet users.
| it is a malicious practice in which
Spoofing cuirnmunication is send from unknown source

disguisec as a scurce known to thc receiver.

2. What is piracy? Mention the types of piracy?
How can it be: preventez

Software Piracy is about the copyright violation of softwa e created

originally by an individual or an institution.
Softwarre ?iracy is “unau-horized copying of software”

S Type o’ L\ . |
No Piracy T'unction
Unauthoriz Unauthor!zed accessiswhen someone gains access
1 ed toawebsite, program, server, service, orother
access system by breakingintoalegitimate useraccount.
) Hacking is gaining unauthorized access tos computer system
2 Hacking | without the owner’s permission.
Crackingis gaining unauthorized access to computer systems
) tocommit acrime, such as stealing the code to make a copy-
3 Cracking - . N
protectedprogramrunthusdenyingservicetolegitimate
users.
Prevented Action:

To pretend being your friend and talk to you on Internet Relay
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3. Write the different types of cyber attacks

13;) ft)tlgﬁll; Function
A virus is a small piece of computer code that can
repeat itself and spreads from one computer to
another by attaching itself to another computer
. file.
1. Virus

Trojan: A Trojan virus is a program that appears
to perform one function (for example, virus
removal) but actually performs malicious activity
when executed.
Worms are self- repeating and do not require a
computer program to attach themselves. Worms
2. | Worms | continually look for vulnerabilities and report back
to the author of the worm when weaknesses are
discovered.
Spyware can be installed on the computer
automatically when the attachments are cpon, by
clicking on links or by downloading infec:ec
software.
Ransomware is a type ol malicious program that |
R demands payment after launching a cyter-attack
ansom ] .
4. ware on a computer system. This type of mal'w are has
become increasirgiy popular among criminals ard |

3. | Spyware

Book Inside rastion
What is Cryp:cgraphy?
Cryptography a key is a piece of information (parameter) that
determines the functional output of a cryptographic algorithm.
Encryption and decryption are done by cryptography
Write TYPES OF ENCRYPTION
There are two types of encryption schemes as listed below:

1. Symmetric Key encryption 2. Public Key encryption
PUBLIC KEY ENCRYPTION Or ASYMMETRIC ENCRYPTION
Public key encryption is also called Asymmetric encryption. It uses the
concept of a key value pair, a different key is used for the encryption
and decryption process. One of the keys is typically known as the
private key and the other is known as the public key.
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Define Asymmetric Encryption in Digital Certificates:

¢ A digital certificate in a client-server model of communication is one
of the example of Asymmetric Encryption.

¢ A certificate is a package of information that identifies a user and a
server.

e It contains information such as an organization’s name, the
organization that issued the certificate, the users’ email address and
country, and user’s public key.

What is Digital Signature

Digital signatures are based on asymmetric cryptography and can
provide assurances of evidence to origin, identity and status of an
electronic document, transaction or message, as well as
acknowledging informed by the signer
Define Ethics

Ethics is a set of moral principles that govern the behavior of an
individual in a society, and Computer ethics is set of moral nrinciples
that regulate the use of ccraputers by users.
Define CYBER CKIME

Cyberc-imie is an intellectual, wiiite-collar ciime. Those whe
commit such crimes generally manipuiate the computer sysiem in an
intelligent manner.
Explain some: Computer crimes sud their functions

Cyber Func:ion
crime || AN N T W Y A
Hacking Hacking is gainir g vnanihorized access to 5 compuer |
evstem without the owner’s ne mission.
Cracking Cracking is gaining unauthorized access to computer

systems to commit a crime, such as stealing the code
to make a copy-protected program run thus denying
service to legitimate users.

Malicious Intentionally doing harm.

Freeware Freeware is a software available free of charge.
Shareware | Shareware is a software that is distributed free of
charge on a trial basis for a limited time.

Phishing Phishing is a term used to describe a malicious
individual or group of individuals who scam users by
sending e-mails or creating web pages that are
designed to collect an individual's online bank, credit
card, or other login information.

What is SOFTWAREPIRACY

Software Piracy is about the copyright violation of software
created originally by an individual or an institution.

Software Piracy is the copyright violation of software created
originally by one person and illegally used by someone else.

Software Piracy is “unauthorized copying of software”

Explain MITM(Man In The Middle)

Man-in-the-middle attack (MITM; also Janus attack) is an attack

where the attacker secretly relays and possibly alters the

communication between two parties who believe they are directly
communicating with each other.

Explain Firewall?

e A firewall is a computer network security based system that
monitors and controls incoming and outgoing network traffic based
on predefined security rules.

e A firewall commonly establishes a block between a trusted internal
computer network and entrusted computer outside the network.

e They are generally categorized as network-based or host-based.

¢ Notwork based firewalls are positioned cn the gateway computers
of LANs [local zica Network] WANs "Vide Area Neiwork] and
‘ntraneis. Hos'-based firewa Is a-e positioned on the network node
itself,

¢ 'The host-bascd iirrewall may be 2 service as i pari: of the operating
system or en agent épylication such as endpoirt security or
protection.

¢ Kach has a role in layered security Firewalls also vary intype
depending on where communication originates, where it is
intercepted, and the state of communication being traced.

Define proxy server

A proxy server is a gateway between a local network and a larger-scale

network such as the Internet. Proxy servers provide increased perfor-

mance and security.

What is use cookies?

+To collect demographic information about who has visited the Web

site.

« Sites often use this information to track how often visitors come to

the site and how long they remain on the site.

« It helps to personalize the user's experience on the Web site.

« Cookies can help store personal information about users so that

Prepared by N Karthick M.C.A., M.Phil., Kingston Matric Hr Sec School, Vandavasi. 604408 Ph : 9150324587

Send Your Questions & Answer Keys to our email id - padasalai.net@gmail.com




www.Padasalai.Net www.TrbTnpsc.com

when a user subsequently returns to the site, a more personalized
experience is provided.
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How to PREVENTION

25% of cyber crime remains unsolved. To protect the information the
following points to be noted:

e Complex password setting can make your surfing secured.

e When the internet is not in use, disconnect it.

e Do NOT open spam mail or emails that have an unfamiliar sender.
e When using anti-virus software, keep it up-to-date.

India Cyber law and IT Act 2000

¢ IT Act 2000 is an act to provide legal recognition for transactions
carried out by means of ElectronicData Interchange(EDI) and other
means of electronic communication.

e It is the primary law in India dealing with cybercrime and electronic
commerce(e-Commerce). e-Commerce is electronic data exchange or
electronic filing of information.

e “Cyber law cr Internet law” is a term that encapsulates the legal
issues related to use ot the Internet.

[}

What are called Fraudulent
Dishonest, cheating, swindling, corript, criminal, llegal,
unlawful.
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